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1.  WELCOME TO THE SOIC SYSTEM!

The Standardized Occupation and Industry Coding (SOIC) System is a software
application that automates the assignment of industry and occupation (I&O) codes
to vital records data. The SOIC System is designed to run on standard IBM
PC-compatible microcomputers.

We have designed the SOIC System to be as easy to use as possible. The
appearance of the program and the commands that you issue follow standards
established by popular modern software. In particular, we have followed
Microsoft’s conventions for Windows applications wherever possible.

As a result, experienced computer users should find it very easy to pick up this
program. If you are relatively inexperienced with computers, however, we
recommend that you read The SOIC System User’s Manual carefully. It will give
you a variety of tips that will make using the program much more convenient. Part
2 of the manual is a "User’s Reference Guide." New and old users can look up
topics in this section, and find answers to specific questions.

Version 1.5 of the SOIC System can run on any computer that supports Microsoft
Windows versions 95, 98, 2000, or Windows NT. We recommend a 90 MHz 
Pentium system with 32 megabytes of RAM (random access memory). You must 
have a hard disk drive with at least 30 megabytes of free disk space. You must 
have even more disk space if you intend to code very large tables. Microsoft 
Internet Explorer must be installed. (See Appendix A “Installing the SOIC System 
on Your Computer” on page 107 for details.) The SOIC System is compatible with 
Novell NetWare local area networks. 

The SOIC System user interface—the “client” application—was developed using
Microsoft Visual Basic version 6 and Microsoft Access 2000. The 1990 Coding
Engine was developed using Borland C++ Builder 4. 

Development of SOIC has been a collaborative effort between the National Institute
for Occupational Safety and Health (NIOSH) and other agencies including the
National Association for Public Health Statistics and Information Systems
(NAPHSIS), the Bureau of Labor Statistics (BLS), the National Center for Heath
Statistics (NCHS), the National Center for Chronic Disease Prevention and Health
Promotion (NCCDPHP), and the United States Bureau of the Census (BOC). This 
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effort has involved input from more than 40 individuals representing various
federal and state organizations with interest and expertise in I&O coding. The 
actual software development has been performed by HGO Technology, Inc.

The SOIC Policy Committee, composed of management representatives from these
partnering agencies, provided overall guidance on the project, ensuring that the 
software meets the needs of its user community. The SOIC Technical Committee, 
composed of coding experts, advised SOIC’s developers on technical and coding 
issues.
 
Windows, Visual Basic, and Access are trademarks of Microsoft Corporation. 
Borland C++ Builder 4 is a trademark of Inprise/Borland Corporation. Other 
brands and product names are trademarks or registered trademarks of their 
respective holders.
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1.1  What is Industry and Occupation Coding?

By manipulating records on large numbers of individuals, researchers can learn
whether individuals with certain characteristics are unusually likely to have other
characteristics. In an example that is particularly relevant to the SOIC System,
researchers can learn, by looking at a large number of cases, whether people who
work in particular occupations and industries are unusually likely to become sick,
injured, or die of particular causes. The number of possible occupations and
industries that may be reported on death certificates and other records, however,
is vast. The 1990 Alphabetical Index of Industries and Occupations, U.S. Bureau of
the Census, lists about 21,000 industry titles and 30,000 occupation titles. 
However, there is no guarantee that persons filling out death certificates and other 
health records will use the titles included in the Alphabetical Index. In fact, an 
enormous variety of titles may show up in these records.

To make this vast range of possible titles manageable, researchers rely on
industry and occupation coders (I&O coders) to classify the “literals”—that is, the
actual titles found on death certificates and other records—into a limited number
of categories.

I&O coding is a labor-intensive, error-prone task. Experienced coders may
disagree at times over which code to assign to a particular literal. Coders must
often contend with literals that are written by persons with no training in how to
describe industries and occupations. In some cases the industry and occupation
fields are switched. Company names may be used instead of actual industries.
Literals can be misspelled or even illegible.

To make the job of the I&O coder easier, and to conserve the effort of skilled
personnel, NIOSH commissioned the SOIC System—a software program to
automate, as much as possible, the assignment of industry and occupation codes. 

Because I&O coding can be a difficult task even for human beings, it follows that
the SOIC System is not capable of assigning correct codes to all literals. By coding
most cases, however, the SOIC System can allow I&O coders to concentrate their
efforts on a relatively small number of cases. The SOIC System uses a variety of
methods for determining codes, including a number of relatively advanced
techniques borrowed from the field of artificial intelligence. The SOIC System,
therefore, is a “state of the art” automated tool for I&O coders.
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1.2  The 1990 Architecture

The SOIC System consists of two principal modules, plus various shared files and
data files. The two modules are the Client and the 1990 Coding Engine. The SOIC
System coding engine classification systems was developed by the Bureau of the
Census and was used in coding industry and occupation for the 1990 census.

The Client. The Client is the part of the system with which SOIC 1.5 users
interact. The Client contains all of the visual components of the SOIC System,
along with data management functions and the on-line help system. The Client
does not contain any code assignment logic. The Client makes code assignments
by requesting the service of the 1990 Coding Engine.

The 1990 Coding Engine. The 1990 coding engine encapsulates the code
assignment logic of the 1990 census I&O coding scheme. The 1990 industrial
classification scheme consists of 236 categories, arranged in 13 major groups. The
1990 occupation classification scheme has 501 separate categories, also arranged
in 13 groups. Both the industry and the occupation codes are three-digit
numbers, and the numbers do not overlap. There are no numbers that can
represent either an industry or an occupation.

The 1990 Coding Engine uses a variant of the 1990 census coding scheme. The 
varient was developed by NCHS and NIOSH, and is used by these two agencies. 
The NCHS/NIOSH system is identical to the BOC scheme for all private-sector and
most public-sector industries and occupations. It provides a small number of 
additional codes, not found in the BOC scheme, for non-workers, unpaid workers, 
and members of the U.S. Armed Forces. The NCHS/NIOSH system is documented 
in Instruction Manual Part 19: Industry and Occupation Coding for Death 
Certificates, 1998, from the Centers for Disease Control and Prevention/National 
Center for Health Statistics (CDC/NCHS).

Component Object Model (COM) Architecture. The coding engine was developed
as a Component Object Model (COM) server. This architecture not only allows the
Client to access different coding engines, but it also facilitates interface to the
coding engine by other external software applications, such as electronic death
registries. Also, periodic updates can be made to the coding logic and new servers
can be distributed to the user community without the need to update the Client.
The coding engine can be invoked from either the SOIC 1.5 Client or any external
32-bit Windows application capable of calling COM components.
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1.3  Entering Vital Records Data Into the SOIC System

The SOIC System offers two principal ways to code I&O literals. The program can
be used as a data entry system. This means you can start up the program with an
empty data table, and enter data from paper copies of vital records. The program
can also code vital records data tables that are already available electronically,
provided that the data can be converted into the right format.

As we explain in detail later in this manual, when you enter the SOIC System,
your computer’s screen is mostly taken up by the Data Entry Form. This form is
based on the U.S. Standard Certificate of Death. The form contains a series of
“fields,” or blank spaces where you can fill in available information. The fields are
in the same order as the items on the U.S. Standard Certificate of Death. Each
screenful of information displayed by the SOIC System is a single record, that is, a
form for a single individual case. You can issue commands to the program that
allow you to page through the records, just as you would page through a stack of
paper documents. The SOIC System, therefore, allows you to immediately begin
entering data from paper records as soon as you enter the program.

As we also explain later in the manual, you can import an existing text data file
into the SOIC System. You can do this using the program’s Import option—see
Section 2.4.7, “The Import Option,” for details. The SOIC System can also directly
use data tables in formats employed by popular database management systems,
including Access, dBASE, and FoxPro. These files do not need to be imported. (You
can import them, however, and this is encouraged.)

Several steps need to be taken in advance if you wish to import data into the
program, or use data prepared by a database management system. First, the data
file must exist in a machine-readable format. Usually, this means the file is stored
on magnetic media such as magnetic tape, a hard disk, or a floppy disk. There
must be a way to transfer the file from its current location to your computer
system. Network connections and floppy disks are two of the most common
methods of transferring files, but others are possible, including remote
transmissions using a modem. 

For a complete description of the file formats supported by the SOIC System, see
Appendix B, “SOIC System Data File Formats.” 
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Once you have entered data into the SOIC System, either by typing in data from
paper records or by using data that is already in an electronic format, you can
code the records using the 1990 coding scheme. You can code all the industry and
occupation titles in the table at once, or code them record by record. You can edit
the coded records, and manually code any literals that the program is unable to
handle by itself. You can divide coded and uncoded records into two separate
tables, for convenience in handling the uncoded records. You can export coded or
uncoded data to a text file for use in other software programs. We explain these
and other procedures throughout the rest of this manual.
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1.4  Conventions Used in This Manual

To help you understand the information we present in this manual, we put certain
kinds of information in specific typefaces. 

The keys on your computer’s keyboard are in small caps:

ESC TAB SHIFT

CTRL SPACE BAR ENTER

LEFT ARROW A B

You must often press more than one key to perform an action. If two keys are
joined by a plus sign, hold down the first, and while holding it down, press the
second:

ALT+BACK SPACE SHIFT+TAB CTRL+F

If keys are to be pressed one after the other, but not simultaneously, they are
joined by a comma:

TAB, DOWN ARROW LEFT ARROW, ENTER DOWN ARROW, ENTER

What would it mean if the following command appeared in the manual?

ALT+F,  S

This would mean: First hold down the ALT and the F keys simultaneously, then
release them, and then press the S key.

Text that you type is in bold italic:

C>soic File Name: yourfile.txt 

In these examples, “C>” and “File Name:” are prompts. What you actually type is
soic or yourfile.txt. 

Note that in many cases, the “text you are to type” is simply an example, which
shows the kind of text you should enter. One such example is yourfile.txt—it is
an example of a file name, and stands for all the other file names you might need
to use while working with the SOIC System.
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1.5  A Quick Tour of the SOIC System

We assume that the SOIC System has been installed on your computer following
the guidelines in “Appendix A: Installing the SOIC System on Your Computer,”
and that you are using one or another version of the Microsoft Windows
environment. Because not everyone using the SOIC System will prefer to use a
mouse, in this introductory tour we give keyboard commands where possible.

1.5.1  The Help System

At any time that you are uncertain about what to do next or what command you
should issue to accomplish a certain result, you can use the SOIC Help System.
The Help System is available from all parts of the program except the message
boxes. No matter which of the program’s windows are currently open, you can
access the Help System by pressing the F1 key on your computer’s keyboard.

The SOIC Help System is “context-sensitive.” That means that when you ask for
help, you will receive a variety of different messages. The Help System checks to
see where you are in the program, and provides you with information tailored to
your actual circumstances. The Help System is therefore “sensitive” to your
“context.” In addition to displaying a topic that responds to your immediate
circumstances, the Help System allows you to browse through an index covering
all the help topics. Once you have spotted a topic in the index that you want to
read, you can open the topic.

1.5.2  Starting the SOIC System

To start using the SOIC System, locate the SOIC System icon. Installation places
the icon in the SOIC2 program folder under Programs on the Start menu, but it
may have been moved or copied after the program was installed. The icon looks
like this:

  SOIC Client

Double-click on the icon to start the program. After start-up, you see an empty
Data Entry Form labeled “untitled”:
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Figure 1

The screen may look slightly different if you have set Windows to a special color
scheme. In all important ways, however, the screen should look the same.

Most people will use the SOIC System to apply occupation and industry codes to
already-existing data files. If you want to enter data directly into the SOIC System
from paper copies of health records, however, you can begin entering data
immediately. 

Whenever the SOIC System is opened, the system opens a special table named
“untitled.” This is a special “dummy” table. You cannot use the untitled table to
permanently store your data. When you leave the SOIC System, the untitled table
is emptied. To store your data permanently, at some point before you leave the
program you must save your data to a different table.
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Figure 2

1.5.3  Opening a Table

At the top of your screen, above the Data Entry Form, is a line containing the
words File, Field, Record, Code, Tools, and Help. This is the menu bar. The menu
bar is the gateway to all parts of the SOIC System other than the Data Entry
Form. Note that the first letter of the first word—the F in File—is underlined. This
is a sign that you can use the letter F with the alt key to access the File menu.
Let’s open the File menu. Press the following: ALT+F. (If you’re not sure what ALT+F

means, see Section 1.4 “Conventions Used in This Manual” on page 7.) After you
press ALT+F, the menu looks like this:

If you were to click on the first line of the open menu—the line that says
“New...”—it would appear in reverse colors from the rest of the menu. The reverse
colors are called “highlighting.” Highlighting is a sign that the highlighted element
is the focus of attention for the program. At any point, one or another element in
the SOIC system is always the focus. Highlighting is one way of marking the focus.
(If the element is a text entry box, the focus is marked by the appearance of a
vertical text cursor.)

Commands that you issue act at the focal point, unless the command affects the
entire program—for example, you can use CTRL+N to choose the New option from
the Data Entry Form, no matter where the focus is located. 

The New option on the File menu is the option we want. The New option allows
you to open a new named table. If you wanted to execute the Open option instead,
you could move the highlighting down to “Open...” by pressing the DOWN ARROW

key once. Try pressing DOWN ARROW once. Then press UP ARROW to return to the
New option. Now press the ENTER key. Pressing ENTER executes the option that you 
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Figure 3

have highlighted. A new window appears, covering part of the Data Entry Form.
The window, which is called a dialog box, looks like this:

(Figure 3 is just an example—the dialog box you see probably has a different list of
table names.)

Notice the small box beneath the words “Table Name.” This is the Table Name text
entry box. There is no name in the Table Name box. When you open the dialog
box, the text cursor is initially located in the Table Name box. Therefore, you can
immediately begin typing in a name for your new table. 

The name can be up to 64 characters long. You can use any combination of
letters, numbers, or other keyboard characters for the name, with a few
restrictions. You can’t use the period (.), exclamation point (!), back quote (`), or
brackets ([]). Also, you can’t use leading spaces or control characters. Table names
can contain either capital or lower-case letters, and are stored with the
capitalization you choose. You cannot distinguish two tables from each other by
capitalization, however. Once you have a table named “Mytable” you can’t save a
new one named “mytable.”

The tables are not stored as separate files. In fact, all SOIC data tables are stored
in a single file, called Userdata.mdb. We explain how the SOIC System stores
tables later in this manual, in Section 2.3 “How the SOIC System Manages Tables
and Files” on page 44, and Section 2.4.2 “The Open Option” on page 50.
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For now, let’s open a new table. Let’s say you type in the following name:

      Table Name:

Mytable

If you decide that you don’t actually want to open a table, you can close the dialog
box at any time without creating a table by pressing ESC or clicking on the Cancel
button with the mouse. Let us say, however, that you do want to use the table
“Mytable.” To do so, press ENTER. The Open dialog box closes, and you return to
the Data Entry Form. At the top of the form, the name of the open table is
displayed:

There is another way you could have chosen the New option, and opened a new
table. Immediately below the menu bar near the top of your screen is a row of
buttons. If you move the mouse pointer over any of these buttons, after a brief
delay a label appears identifying the button: “New Table,” “Open Table,” “Save
Table As,” “Import,” and so on. With the mouse, you can click on one of these
buttons and activate an option. Clicking on the New Table button has the same
effect as pressing ALT+F, N on the keyboard.

1.5.4  Moving About the SOIC System

Now that you are back in the Data Entry Form, notice that the text cursor is again
in the Local ID field. When you close a dialog box, the focus always returns to the
field that was selected when you opened the box. 

Let’s say you want to enter data into “Mytable” manually, from a stack of paper
death certificates. You’ve been told that for this case, not all of the fields in the
Data Entry Form need to be filled in. You need to enter the following data,
contained in three records:
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Record 1 Record 2 Record 3

Local ID 1001 1001 1001

Certificate ID 50001 50002 50003

Date of Death 11/13/1989 09/16/1987 08/19/1988

Date of Birth 07/11/1927 05/09/1906 02/03/1938

Occupation sales clerk housewife miner

Industry department store farm coal mine

Notice in the bar at the bottom of the screen is the statement:

Record 1 of 1

A message similar to this is always present when the Data Entry Form is active. It
lets you know which record is displayed, and how many records there are in the
table. Because you have opened a new, empty table, there is only one blank
record, and it is displayed.

Because the text cursor is in the Local ID field, you can immediately enter the first
item of the first record. Type 1001. If you make a mistake, you can use BACK

SPACE or DELETE to erase your error. You can use LEFT ARROW and RIGHT ARROW to
move the cursor backward or forward through the text to insert characters.
Characters are inserted immediately after the cursor.

Once you have typed 1001, you will want to move to the next field in which you
need to enter data, Certificate ID. To do so, press TAB twice. The text cursor moves
to the Temporary ID field and then to the Certificate ID field. The first Certificate
ID is 50001, and you can type 50001 into the field.

You can now move to the next field with TAB. You must press TAB six times to get
to the next field for which you have data, the Date of Death field. Isn’t there an
easier way to move the focus? There is. With the mouse, you can move the focus
to a new field by placing the mouse pointer inside the new field’s text entry box
and clicking the left mouse button once. 
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Figure 4

The Date of Death field already contains a number of characters—two slashes to
separate the month, day, and year. As you type in the digits, notice that your
cursor skips over the slashes. When you are done, the Date of Death field should
look like this:

Date of Death:       11 / 12 / 1989

You can now move the cursor to the Date of Birth field with TAB or the mouse.
Type in the following numbers: 07111927. The field should look like this:

Date of Birth:         07 / 11 / 1927

By this time, you know all the commands you need to finish entering the last two
items into record 1: 
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To fill out record 2, press CTRL+INSERT. This adds a new, blank record to the table,
and takes you to the new record. If you press CTRL+INSERT again, the third record
is created. 

To return to the second record to finish filling it out, press PAGE UP. Notice what
happens to the focus. PAGE DOWN and PAGE UP keep the focus on the same field as
you move from record to record.

There is another way to move from record to record, in addition to using PAGE

DOWN or PAGE UP. On the button bar at the top of your screen are four buttons that
look like the controls on a VCR: 

You can use these buttons by clicking on any of them with the mouse. The first
button moves to the first record of the table. The second is equivalent to PAGE UP.
The third is equivalent to PAGE DOWN. The last button moves to the last record of
the table.

Whenever you press PAGE DOWN or PAGE UP to move to a different record, or use the
VCR buttons, the SOIC System automatically saves the record you have just left. If
you open another table, the SOIC System closes the first table and saves all
records. Any other method of leaving a record—through the Find option, for
example, or by coding a table—also saves the record. If for some reason your
computer should loose electrical power while the SOIC System is running, the
only data you can lose is whatever changes you may have made to the currently
active record. 

Special note: The SOIC System’s ability to save all but the current record in
the event of emergency power loss should not be relied upon during everyday
use. In years past, some people habitually turned off their computers before
they closed active programs and before they closed Windows. This was always a
dangerous practice that could lead to corrupt files, loss of free disk space, or
the destruction of Windows configuration data. Under Windows 95, 98, or
2000, it also results in extended delays the next time the computer is started,
as Windows attempts to repair the damage caused by the unexpected
shut-down.  Always take the time to exit your software properly!
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1.5.5  Coding a Record—and Then the Whole Table

Now that you have put data into the three records of the sample table, let’s use
the SOIC System to do the job for which it was written. Let’s obtain industry and
occupation codes for these three cases. First, if the program is displaying the 
second or third record, return to the first record. You can do this through the data
control, or you can do it through the keyboard by pressing CTRL+HOME. (You don’t
have to be at the first record to code the table, but starting there will make it
easier to follow our example.)

Now that you’re back at the first record, you can find the coding commands under
the Code pull-down menu, on the menu bar at the top of your computer’s screen.
Remember that ALT+F pulled down the File menu. The first letter of Coding—C—is
underlined, so ALT+C pulls down the Code menu. 

There are four options on the Code menu. The one we want to try first is Code
Record. Because Record is highlighted when you press ALT+C, you can execute this
option by pressing ENTER immediately. 

Alternatively, you could execute the option by pressing the “hot key” listed to the
right of Record on the option line—CTRL+R—directly from the Data Entry Form.
You can’t use the hot keys while the menus are open, so if you want to use CTRL+R

you must close the menu. You can do so either by pressing ESC twice (represented
by ESC, ESC) or by clicking on the Data Entry Form with the mouse. 

An additional way to choose the Code Record option is to click on the Code Record
button with the mouse. The Code Record button is immediately to the right of the
VCR controls.

Let’s use the Code Record button to code a record. If you haven’t done so already,
close the Coding menu with ESC, ESC or the mouse. Then click on the Code Record
button. When the coding is done, the screen looks like this:
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Figure 5

The occupation code is now in the occupation Code field, to the right of the
Occupation field. The industry code is in the industry Code field, to the right of
the Industry field.

Note the “balloon” located immediately below the industry Code field that says
“department stores.” This is a definition of the code 591. You can see definition
balloons for industry and occupation codes by placing the mouse pointer in a
Code field and waiting about half a second. The definition balloons only appear
when there is actually a code in the Code field. You cannot display them by using
the keyboard.

Recall that on the Code menu, the hot key for Table is CTRL+T. Let’s use CTRL+T

and code the rest of the table. With only three records, coding takes place quickly.
When the coding is finished, the system displays the following box:
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Figure 6

Click the OK button to return to the Data Entry Form. You can use PAGE UP and

PAGE DOWN to view the results of the coding.

1.5.6  Leaving the SOIC System

The command to leave the SOIC System is listed on the File pull-down menu, and

you can see it by pressing ALT+F. The option is Exit, and you can execute it in

several ways. While the menu is open, you can press x to choose the Exit option

(note that the X in Exit is underlined). From anywhere in the program, you can

issue the standard Windows exit command ALT+F4. (If a dialog box is open, ALT+F4

will only close the dialog box. You can then press ALT+F4 again to leave the

program altogether.) Other standard methods of leaving Windows programs also

work. This includes clicking on the box with an X in the far top-right corner of the

screen.
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2.  USER’S REFERENCE GUIDE

The following part of The SOIC System User’s Manual, the “User’s Reference
Guide,” gives complete details about specific features of the SOIC System. The
guide can serve as reference material when you want to look up information about
a particular topic. We have also written the “User’s Reference Guide” so that you
can read it straight through if you wish. Because it is a reference guide, however,
it is necessarily somewhat repetitious.

If you are already familiar with Windows programs, you may find sections 2.1 and
2.2 to be very elementary—you can certainly skip these sections.
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Figure 7

2.1  The Parts of the SOIC System

The parts of the SOIC System that you can actually see—the parts that let you
enter data, view the data, and give commands—consist of a number of box-shaped
windows. The following part of this manual describes the windows that you see
when the SOIC System is running. The most important of these windows is the
Data Entry Form, the window that you see when you start up the SOIC System. In
addition to the Data Entry Form, on start-up the screen shows several other
important parts of the system, which include the menu bar at the top of the
screen, the Button Bar, and the Status Bar at the bottom of the screen.

2.1.1  The Data Entry Form

The following figure shows the Data Entry Form:

On the main part of the form are a series of data entry fields. These fields contain
white boxes placed immediately after the field labels. You can enter text in these
boxes. The first field—the field in the top-most left-hand corner—is labeled Local 
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ID. The next field, reading left to right, is Temporary ID. The fourth field is First
Name.

On start-up, the first field—Local ID—has a blinking vertical bar inside the box,
near the right edge. This bar is the text cursor. It is a sign that this field is
“selected,” that it is the current focus of attention. If you begin typing, the letters
and numbers that you type appear in this field. The text cursor shows you exactly
where the text will go. If you have entered text, you can reposition the text cursor
with the LEFT ARROW and RIGHT ARROW keys. If you then resume entering text, the
text is placed at the new location of the text cursor. For more information on these
topics, see Section 2.2.7 “The Arrow Keys” on page 38.

You can also move the text cursor from one position in a text string to another
with the mouse. Place the mouse pointer on the space where you want the text
cursor to appear, and click. Note that the text cursor can move to the end of a text
string, but no further. If you click on a blank space in the box to the right of the
string, the text cursor moves to the end of the string. You can use the mouse to
select text for editing. Place the mouse pointer at the beginning of the string,
depress the button, move the mouse pointer to the end of the string, and release.

Some of the fields contain formatting characters. An example of this is the field
Social Security, which contains underlining and two dashes. The dashes serve to
break up the Social Security number into its standard format—three numbers,
followed by two numbers, and then four numbers. When you type text into fields
with formatting characters, do not type the characters or spaces to allow for the
characters. If you type in spaces or characters, they appear as part of the text. 

Whenever the Data Entry Form is active, one or another of the data entry fields is
always selected. You can change the selected field—move the text cursor—by
using the TAB key, or by moving the mouse cursor to a new field and clicking the
mouse button. If you click outside of the boxes on the Data Entry Form, nothing
happens.

It is possible to suppress the display of one or more fields on the Data Entry Form
with the Suppress option on the Field menu. For more information, see Section
2.5.2 “The Suppress Fields Option” on page 79.
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2.1.2  The Title Bar

The title bar appears at the top of the screen, above the Data Entry Form. The title
is “SOIC -” plus, in single quotes, the name of the table that is in use. When you
open the program, the table in use is always an empty table called “untitled”:

The title bar also contains several standard Windows controls for manipulating
the open application. These include three small boxes to the far right of the title
bar. If you click on the box with an underline character, Windows minimizes the
SOIC System without exiting from the program. If you click on the box with an X,
you exit from the SOIC System. The box that in many programs can be used to
switch between a maximum-sized window and a reduced-size window is grayed
out and disabled. 

The SOIC icon that appears on the far left is also a control. If you click on it, a
Windows “system menu” drops down giving you controls that match the ones
provided by the boxes to the far right:

This menu is designed for controlling programs without using the mouse—you can
also open it with ALT+SPACE BAR and then use the arrow keys to select the option
you want. Press ENTER to activate your selection.

2.1.3  The Menu System

At the top of the screen, above the Data Entry Form, is a line containing five
items: File, Field, Record, Code, Tools, and Help. This line is the menu bar, and it
is the gateway to all other parts of the SOIC System beyond the Data Entry Form.
Each of the items on the menu bar is the title of a pull-down menu containing
options from which you can choose. To open a pull-down menu, you can type the 
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Figure 10

ALT key plus the first letter of the title (which is underlined). For example, to open
the File pull-down menu, type ALT+F:

Alternatively, you can click on the word “File” with the mouse. Either procedure
opens the File pull-down menu. If you want to choose the New option, you can
press ENTER, click on New with the mouse, or type the letter N, which is
underlined. This opens the New dialog box. 

If you want to choose a different option—say, the Open option—you can click on
Open with the mouse, or type the letter O, which is underlined. Alternatively, you
can move the highlighting to the Open option by pressing DOWN ARROW, and then
display the Open dialog box with ENTER. 

If you choose an option by clicking on it with the mouse, the option is immediately
executed—there is no interval during which the option is highlighted but not
activated, as there would be if you highlighted an option with DOWN ARROW and
then activated it with ENTER. 

We describe the file management dialog boxes in detail in Section 2.1.6 “ Dialog
Boxes to Manage Files and Tables” on page 25. For now, consider the File
pull-down menu. The menu has ten options. Seven of the options are followed by
three dots. The dots mean that choosing this option opens a dialog box that offers
additional options. One option—Save—has an arrow symbol to the right of the
option label. This means that choosing Save opens a “submenu” with more
options.
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Close and Exit have no dots or arrow symbols. This means that if you choose one
of these options, it is executed immediately.

You can close a pull-down menu and return to the Data Entry Form either by
pressing ESC twice (ESC, ESC) or by clicking on the Data Entry Form with the
mouse. As long as a pull-down menu is open, none of the fields on the Data Entry
Form are selected. If you return to the Data Entry Form by pressing ESC twice, the
field that was selected when you opened the menu is selected again. If you return
to the Data Entry Form by clicking on an area outside any of the fields with the
mouse, the field that was selected when you opened the menu is also selected
again. If you return to the form by clicking on a new field that was not previously
selected, however, the text cursor moves to the new field.

If one of the pull-down menus is open, and you want to move to a different menu,
you do not need to return to the Data Entry Form first. Instead, you can use LEFT

ARROW or RIGHT ARROW to move from one pull-down menu to another.

If, after opening a menu, you decide that you would rather open another, you can
do so with the mouse by moving the mouse pointer to the other menu. You can
drag the pointer through the menus until you find the option you want, and then
click the left mouse button.

The options available through the menu system are described in detail throughout
the following sections:

! Section 2.4 “The File Menu” on page 49.

! Section 2.5 “The Field Menu” on page 79.

! Section 2.6 “The Record Menu” on page 82.

! Section 2.7 “The Code Menu” one page 88.

! Section 2.8 “The Tools Menu” on page 92.

! Section 2.9 “The Help Menu” on page 103. 

2.1.4  The Button Bar

Immediately below the Menu Bar lies the Button Bar:
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All of the options available through the Button Bar are also available from the
drop-down menus on the Menu Bar. The Button Bar simply places these options
in a conspicuous location so that they are easy to find. You can execute any
Button Bar option by clicking on the appropriate button with the mouse.
Whenever you move the mouse pointer over one of the buttons, a “tool tips”
balloon appears to tell you in greater detail what the button does. The Button Bar
buttons cannot be accessed through the keyboard.

2.1.5  The Status Bar

The Status Bar is located at the bottom of the screen, below the Data Entry Form:

The Status Bar contains four indicators that provide useful information about the
status of the system. The first of these, taking up most of the left-hand side of the
bar, is the Coding Progress indicator. This display appears when large tables are
coded, and shows how much coding is left:

The next indicator is the Record Number, which shows the record number of the
current  record, and how many records are in the table.

The third indicator shows the server that is in use for coding records—the 1990
Server. For more information about this server, see Section 1.2 “The 1990 Coding 
Architecture” on page 4.

The last indicator displays the time of day. If you like, you can disable this display
through the Settings option on the Tools menu. 

2.1.6  Dialog Boxes to Manage Files and Tables

The first six options on the Files menu display dialog boxes that allow you to
manage tables. The next two options, Import and Export, display dialog boxes for
managing files. (The Convert Access option under the Tools menu also opens a file
management dialog box.) Additional file management dialog boxes are available
through the Data Source control in many of the table management dialog boxes. 
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These additional dialog boxes allow the SOIC System to work with external data
stored in Access or Xbase files.

The table management dialog boxes are part of the SOIC System, and look the
same no matter which operating system you are using—Windows 95, 98, 2000, or
NT. The file management dialog boxes, however, are generated by Windows itself,
not by the SOIC System. Under Windows 95, 98, and NT, the file management
dialog boxes have substantially the same appearance. (Examples shown in this
manual were generated using Windows 98.) Under Windows 2000, file
management dialog boxes have a somewhat different appearance. Some controls
are in new locations, and there are controls that do not exist under Windows 95,
98, and NT. The Windows 2000 file management dialog boxes, however, have all
the functionality provided by dialog boxes in earlier versions of Windows. 

Note that the menu bar and part of the Data Entry Form are still visible while the
dialog boxes are open. Though visible, these parts of the program are inactive. You
cannot access them until you close the dialog box and return to the Data Entry
Form.

We describe the uses of each dialog box in the section on the Menu Bar option
used to invoke it—see the following:

! Section 2.4.1 “The New Option” on page 49.

! Section 2.4.2 “The Open Option” on page 50.

! Section 2.4.2.1 “Opening a Non-SOIC Access Table” on page 52.

! Section 2.4.2.2 “Opening an Xbase File” on page 60.

! Section 2.4.4.1 “Save Coded” on page 62.

! Section 2.4.4.2 “Save Uncoded” on page 63.

! Section 2.4.4.3 “Save 998 Codes” on page 64.

! Section 2.4.5 “The Save As Option” on page 64.

! Section 2.4.6 “The Delete Option” on page 67.

! Section 2.4.7 “The Import Option” on page 68.

! Section 2.4.8 “The Export Option” on page 75.

! Section 2.8.5 “The Convert Access Database Option” on page 97.
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Figure 11

In the following part of this section, we describe common methods of moving
about and manipulating dialog boxes, and common elements that all the dialog
boxes share. If you have questions about basic Windows operations, you can
consult any Windows manual or guide.

Take as an example the Open Table dialog box, the box users will probably see
most often. The Open Table dialog box looks like this:

This dialog box contains the following elements:

! A text entry field (labeled Table Name).

! A list box.

! Buttons.

! A “drop-down combo box” (labeled Data Source) that combines a drop-down
list with a display field.

2.1.6.1  Moving the Focus in a Dialog Box

When the Open Table dialog box is initially displayed, the text cursor is in the
text entry box of the Table Name field (the only text entry field in this dialog
box). Therefore, you can immediately begin typing in the name of a table that
you want to open.
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You can choose and activate another element in the dialog box by clicking on it
with the mouse. Clicking on Cancel closes the dialog box without taking any
action. Clicking on OK accepts whatever text is placed in the Table Name field,
and the program then tries to open that table. Clicking on a name in the Table
Names list box places that name in the Table Name field. Clicking on the Data
Source display field (or on the arrow button next to it) opens a drop-down list
that allows you to open various kinds of external, non-SOIC tables or files. 

In addition to using the mouse, you can also move the focus from one element
to another with TAB or SHIFT+TAB. TAB cycles the focus forward through the
elements; SHIFT+TAB also cycles the focus, but in the opposite direction. Unlike
the mouse, TAB selects elements but does not immediately activate them. You
can use TAB to select the Cancel button, for example, without closing the dialog
box. To actually close the box, first select Cancel and then press ENTER.
(Alternatively, to close a box you could simply press ESC, no matter which
element in the box is selected.)

2.1.6.2  How to Tell if A Dialog Box Element is Selected

Sometimes it is necessary to look closely to tell whether a dialog box element is
selected. Sometimes the signs are obvious enough. When the Table Name text
entry field is selected, the text cursor appears in the text entry box. When the
Data Source element is selected, reverse highlighting makes the selection easy
to see.

Other selected dialog box items, however, display subtler markings. Signs that
an element is highlighted include a dotted line around the element label, and
sometimes a darkening of the object’s border. For example, in the following
illustration, the OK button is selected, and the Cancel button is not:
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2.1.6.3  Text Entry Fields

A text entry field, such as the Table Name field in the Open Table dialog box,
typically consists of a label (Table Name:) and a text entry box. When the field
is selected, the text cursor appears in the box. Text entry boxes support all
standard Windows text-entry features (though all the text entry boxes in the
SOIC system are single-line boxes, and ENTER does not create a new line). 

From the keyboard, you can move forward through text with RIGHT ARROW and
back with LEFT ARROW. HOME moves the cursor to the beginning of the line, and
END moves immediately after any displayed text. You can move word-by-word
with CTRL+RIGHT ARROW or CTRL+LEFT ARROW. You can select text by placing the
cursor at the beginning of a text block, and then holding down SHIFT as you
move the cursor to the end of the block. You can delete selected text with
DELETE. You can even cut, copy, and paste within and between text fields using
CTRL+X, CTRL+C, and CTRL+V. Insert is not supported—the normal insert mode is
in effect at all times, and pressing insert does not allow you to type over and
replace existing text.

Normal mouse actions for text entry are also available. You can move the text
cursor with a mouse click. To select a block of text, hold down the mouse
button with the mouse pointer at the beginning of a block, drag the mouse
pointer to the end of the block, and release the button.

2.1.6.4  Display Fields

Display fields contain information that can be changed by various program
actions. The display fields themselves cannot be directly edited. In the Open
Table dialog box, the Data Source field is a display field that cannot be directly
edited. You can change its contents, however, through a drop-down list.
Clicking on the field or its associated down-arrow button opens a list from
which you can choose an alternate data source.

2.1.6.5  List Boxes and Drop-Down Lists

The Open Table dialog box contains one list box: the File Names list box
immediately below the File Name field. You can copy a file name to the text
entry box by selecting it from the list box. Clicking on a name with the mouse
copies the name to the text entry box immediately. You can also move the focus 
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to the list box with TAB, and then move the focus down the list of file names
with DOWN ARROW. When you reach the file name you want, press ENTER to copy
the name to the text entry box.

As in the case of a text entry box, you use the arrow keys to move about within
the dialog box element, and TAB or SHIFT+TAB to move from one element to
another. This is a general rule for dialog boxes.

If the file name you want is too far down the list to be immediately displayed,
you can scroll down the list with DOWN ARROW, or use the mouse to operate the
scroll bar on the right-hand side of the list box.

Some lists would take up too much room in a dialog box if they were displayed
in full, even with the scroll-bar feature. Such lists expand when you click on
them with the mouse. There is one drop-down list in the Open Table dialog box:
the Data Source drop-down list. The field containing the drop-down list
normally looks like this:

When the list is opened, the field looks like this:

The items on the list represent file management dialog boxes that allow you to
open files created using the Access, dBASE, or FoxPro database management
systems. You can move up or down the list with the arrow keys. To actually
display one of the other dialog boxes, you must first select the appropriate
name from the list and then press ENTER.

To manipulate a drop-down list from the keyboard, without using the mouse,
press DOWN ARROW or UP ARROW to scroll through the list items without dropping
the list. You can also drop the list with ALT+DOWN ARROW, then move up or down
the list with the arrow keys. When you have highlighted the item you want,
press ENTER.
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Figure 12

2.1.7  The Message Boxes

In addition to dialog boxes for table and file management, the SOIC System
contains a variety of message and dialog boxes to provide you with information or
alert you to potential problems. Some of the messages provide relatively routine
information, such as announcing that a table is done coding. Other messages
warn you of potentially dangerous conditions. An additional kind of message
warns you that an error has occurred.

When a message or warning box appears, you must choose one of the buttons in
the box to close the box and proceed. You can do so by clicking on one of the
buttons with the mouse. Some boxes may only have a single OK button. To close
the box and proceed, you must click on that button (or press ESC or ENTER). Other
boxes may have several buttons. The Cancel button always closes a box without
taking action, and is equivalent to ESC. OK closes the box and accepts the action,
if any. It is equivalent to ENTER. Other options, such as Yes or No, take their
meaning from the text in the box. 

Unlike the pull-down menus, you cannot close a message box by clicking outside
of it on the main window.

Consider three sample message boxes. The first message box, shown in Figure 6
on page 18, is an information box that appears when you are done coding a table.
The box contains a single button, OK. To close the box, you can either click on the
button with the mouse, press ESC, or press ENTER.

The second message, shown in Figure 12, is a question box that appears if you
choose the Delete option from the Record menu, or press CTRL+D. It seeks to verify
whether you really want to move a record out of the table and into the Trash Can.
Click on OK or press ENTER to proceed; click on Cancel or press ESC to back out of
the deletion. 
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Figure 13

The third message, is an error message. It appears if, when one of the table
management dialog boxes is open, you click on the OK button without first
entering a table name.
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2.2  Hot Keys

Like most software programs, the SOIC System provides a variety of special keys
and key combinations that you can use to control the program. The following
sections describe these keys and key combinations.

2.2.1  Hot Keys In Brief

The table on the following pages lists the hot keys available in the SOIC System,
together with their function. Many of the functions available through hot keys are
also available by selecting an option from the menu system. The Menu column of
the table shows under which menu bar item you can find a particular command.

Keys Menu Action

ALT+BACK SPACE Field Undo field (replace contents with original contents).

ALT+DOWN ARROW Open a drop-down list

ALT+F4 File Quit the SOIC System (or close a dialog box).

BACK SPACE In text entry, remove the character before the cursor.

CTRL+C In text entry, copy selected text (and save in buffer).

CTRL+D Record Delete a record.

CTRL+END Record Go to the last record; keep the focus on the current field.

CTRL+H Equivalent to BACK SPACE.

CTRL+HOME Record Go to the first record; keep the focus on the current field.

CTRL+INSERT Record Create a new record at the end of the table.

CTRL+O Code Code from the current record through the end of the table.

CTRL+R Code Code the active record for industry and occupation.

CTRL+T Code Code the open table for industry and occupation.

CTRL+U Code Code only the uncoded records in the table.

CTRL+V In text entry, insert text (from buffer).
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CTRL+X Code In text entry, cut or delete selected text (and save in buffer).
When coding is in process, interrupt the coding.

CTRL+Z Record Undo all changes to the current record.

DELETE In text entry, remove the character following the cursor.

DOWN ARROW Move down one item within a menu, list box, or drop-down list. 

END In text entry, go to the end of the text. In a list box, go to the last
item.

ENTER Depending on location, perform an action or choose an option.

ESC Depending on location: cancel an action, close a dialog or
message box without taking action, close help, or close a menu.

F1 Help Invoke context-sensitive help.

F2 Record Search for a record in the open table (Find).

F3 Display the next result from the most recent Find operation.

HOME In text entry, go to the beginning of the text. In a list box, go to the
first item.

LEFT ARROW Move left one character within a text entry field or one item in a
multi-column dialog box list.

PAGE DOWN Record Go to the next record; keep the focus on the current field.

PAGE UP Record Go to the previous record; keep the focus on the current field.

RIGHT ARROW Move right one character within a text entry field or one item in a
multi-column dialog box list.

SHIFT+TAB Go to the previous field in a record or dialog box.

SPACE BAR When a check box is highlighted, insert or remove the check.
When a button is highlighted, equivalent to ENTER. In a text field,
insert a space character.

TAB Go to the next field in a record or dialog box.

UP ARROW Move up one item within a menu, list box, or drop-down list.
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2.2.2   Accessing Help Through F1

You can access context-sensitive help from almost anywhere within the SOIC
System by pressing F1. (Help is not available when a message box is open.)
Context-sensitive help displays a screen with text that describes whatever window,
field, or other element was selected before you pressed F1. For example, if the
Local ID field on the Data Entry Form is selected, pressing F1 brings up a window
containing information on the Local ID field. 

The SOIC Help System is managed by the Windows Help application, a software
program supplied with all copies of Microsoft Windows. Windows Help runs as a
separate program from the SOIC System. It is therefore possible to switch back
and forth between SOIC and SOIC Help. The Windows keyboard command ALT+TAB

switches between running programs.

You can close Help by clicking on the Cancel button at the bottom of the Help
window. You can also close Help by pressing either ESC or ALT+F4. Finally, you can
close Help by clicking on the x box in the upper right-hand corner of the Help
window. 

You can get help on Help itself. Help on the Help System is available from within
the Help System by pressing F1. This “help-on-help” is context-sensitive. When
Contents or one of the other topics is displayed, F1 opens a Windows help-on-help
file that allows you to search for any help-on-help topic. If Index or Find is
displayed, F1 displays small “balloon” boxes. The balloons describe the element of
the Help window that is currently selected.

2.2.3 ALT+F4

ALT+F4 is the standard key combination for exiting a Microsoft Windows program.
You can use it from the Data Entry Form to leave the SOIC System and return to
Windows. You do not need to save your work before quitting the SOIC
System—the program automatically saves each record as soon as you leave that
record. Quitting saves whichever record is displayed when you issue the quit
command.

In some cases, ALT+F4 does not quit the SOIC System. If a file management dialog
box or the Help System is open, ALT+F4 closes the box or the Help System. You
can then press ALT+F4 again to leave the program entirely. If most other kinds of 
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message or dialog boxes are open, ALT+F4 has no effect. You must first close the
box with ENTER or ESC before quitting the program. 

2.2.4  ESC

ESC, the escape key, has a generic meaning of “cancel.” The meaning of “cancel”
depends on what else is happening when you press ESC. In general, if you have
opened a dialog box or a pull-down menu, ESC closes it. 

! If a pull-down menu is open, ESC closes it. The focus, however, remains on the
menu bar. Pressing ESC again returns the focus to whichever field was selected
when the menu system was invoked.

! If a dialog box, message box, or Help window is open, ESC closes the box or
window without taking any other action. The box or window is closed
regardless of which item in the box or window is selected. You return to
whichever field on the Data Entry Form was highlighted when the box or
window was opened.

2.2.5  ENTER

On IBM PC-compatible computers, ENTER is sometimes also called “carriage
return” because in word-processing software it commonly emulates a typewriter’s
carriage return. In the SOIC System, ENTER has a generic meaning of “accept.”
What accept means, in turn, depends on what else is happening when you press
this key. The following paragraphs list the effects of ENTER in detail.

! If a pull-down menu is open, ENTER executes the menu option that is
highlighted. The appropriate action is performed. For example: If the File
pull-down menu is displayed and the Open option is highlighted, ENTER

displays the Open Table dialog box.

! When a dialog box is open, pressing ENTER takes action on whatever element is
selected. For example, let us say you have displayed the Open Table box. If a
table name is displayed in the Table Name text entry field, and if either the
Table Name field, the Table Names list box, or OK are selected, ENTER opens the
selected table and returns you to the Data Entry Form. If one of the data
source types in the Data Source drop-down list is highlighted, the program
opens the appropriate file management dialog box. (For details, see Section 
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2.4.2 “The Open Option” on page 50.) If the Cancel button is highlighted,
pressing ENTER executes cancel, which closes the dialog box without taking any
action. (In this case, acting on the selected item has the same effect as if you
pressed ESC.)

! When an open message box contains two or more options, one of them is
highlighted. If you immediately press ENTER, you execute the initially
highlighted option and close the box. If you move to a different option with TAB,
and then press ENTER, the newly highlighted option is executed.

2.2.6  TAB and SHIFT+TAB

TAB moves the focus from the currently selected field to the next field in the Data
Entry Form, a dialog box, or a message box. In the Data Entry Form, if there is a
data entry field immediately to the right of the currently selected field, TAB moves
the text cursor one field to the right. If the highlighted field is the right-most
column of the Data Entry Form, TAB selects the first (left-most) field on the next
line down. If the highlighted field is the last field—the field in the bottom-most
right-hand corner—TAB moves the highlighting to the first field—the field in the
top-most left-hand corner. That is, TAB wraps.

In dialog boxes, TAB moves the focus down the column, and then down the next
column to the right. 

In a message box with two or more buttons—for example, Yes, No, and
Cancel—TAB moves the highlighting one button to the right, and when it reaches
the right-most button, it wraps to the left-most button.

TAB has no effect within text entry fields—that is, TAB does not insert a “tab
character” or a series of spaces in a text field. Instead, it always moves to the next
field.

TAB also does not move between the items in a dialog box list box. Instead of
moving between these items, it moves to the next field altogether. For example,
say you have displayed the Open Table dialog box, and moved to the Table Names
list box with a single TAB. The name of the first table is selected. Note that the
table name is not yet highlighted (though it is surrounded by a dotted line) and
has not been copied to the Table Name text entry field. To actually choose the
name and open the table, you must press one of the arrow keys. Let us say there 
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is another table name further on down the list that you want to choose
instead—“Yourdata.” To move the highlighting to "Yourdata" you must use the
arrow keys. If you press TAB again, you move the focus out of the list box and to
the next element, the OK button.

SHIFT+TAB works exactly like TAB in all contexts, but in the opposite direction. For
example, in the Data Entry Form, SHIFT+TAB moves the text cursor to the previous
field. It also wraps, just as TAB does. 

2.2.7  The Arrow Keys

Like TAB, the arrow keys are used for navigation. Unlike TAB, the arrow keys never
move the focus from one field to another. The arrow keys only move the focus
within a field. 

For example, on the Data Entry Form, TAB moves the focus from one text entry
box to the next, but LEFT ARROW and RIGHT ARROW move the focus within a box, left
or right along a text string.

In a dialog box, TAB and SHIFT+TAB move the focus among the elements within the
dialog box. The arrow keys, in contrast, move the focus within the elements. You
can use them to move down or up within a list box containing table, file, or folder
names.

In a text field, CTRL+LEFT ARROW moves the cursor back one word at a time.
Likewise, CTRL+RIGHT ARROW moves the cursor forward one word at a time. When
moving between items in list boxes, CTRL+LEFT ARROW is identical to LEFT ARROW,
and CTRL+RIGHT ARROW is identical to RIGHT ARROW. When a text field is limited to a
single line, which is the case throughout the SOIC System, UP ARROW behaves like
LEFT ARROW, and RIGHT ARROW behaves like DOWN ARROW.

When you move the highlighting to the menu bar (by pressing ALT+F, ALT+I, etc.)
and one of the pull-down menus opens, you can use LEFT ARROW and RIGHT ARROW

to move left or right along the menu bar. If the File menu is open, for example,
pressing RIGHT ARROW closes the File menu and opens the Field menu. The first
option on the Field menu is highlighted, no matter which option was highlighted
on the File menu. If you press RIGHT ARROW when the Help menu—the right-most
menu—is open, you close the Help menu and open the Windows Control-Menu
box on the Title Bar. Pressing RIGHT ARROW once more opens the File menu.  That 
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is, RIGHT ARROW wraps. LEFT ARROW works in the same way as RIGHT ARROW, but in
the opposite direction.

When a pull-down menu is open, DOWN ARROW moves the highlighting down one
item on the menu. For example, if the File menu is open and you press DOWN

ARROW twice, the highlighting moves from the New option to the Save option.

If the bottom-most menu item is highlighted and you press DOWN ARROW, the
highlighting moves to the top-most item—DOWN ARROW wraps.

UP ARROW works in the same way as DOWN ARROW, but moves the highlighting up,
not down. If you press UP ARROW when the top-most menu item is highlighted, the
highlighting moves to the bottom-most item—UP ARROW wraps. This action of UP

ARROW gives you a convenient way of choosing menu options that are listed at the
bottom of menus. For example, starting from the Data Entry Form, you can leave
the SOIC System by pressing the following keys: ALT+F, UP ARROW, ENTER.

2.2.8  DELETE and BACK SPACE

DELETE and BACK SPACE are active only when you have selected a text entry field
that contains text, such as a data entry field on the Data Entry Form or a Table
Name field in the table management dialog boxes. In all other cases, DELETE and
BACK SPACE have no effect. 

DELETE removes the character in the text string that is to the right of the text
cursor. If you press DELETE repeatedly, you remove all the characters through the
end of the string. When there are no more characters left to remove, DELETE has no
effect.

BACK SPACE removes the character immediately to the left of the text cursor. If you
press BACK SPACE repeatedly, you remove all the characters through the beginning
of the string. When no more characters remain at the beginning, BACK SPACE has
no effect.

2.2.9  PAGE DOWN and PAGE UP

When the Data Entry Form is active, PAGE DOWN moves from the currently
displayed record to the next record. If record 1 is displayed, PAGE DOWN displays 
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record 2. PAGE DOWN places the text cursor in the same data entry field that was
previously in focus. The cursor is at the beginning of the field.

When you move to the next record in the Data Entry Form, PAGE DOWN saves the
contents of the old record—the record you have just left. If you return to that
record, you can no longer restore it to an earlier state by pressing CTRL+Z. (See
Section 2.6.7 “The Undo Record Option” on page 86.)

The SOIC System can be configured to require that every record contain an entry
in the Certificate ID field. If this requirement is active, it is enforced by a message
box that appears if you leave a record that has nothing entered in this field. (See
Figure 46 on page 93.)

If you press ENTER or click on the OK button with the mouse, this message box
closes, and you continue the move to your chosen destination. Alternatively, you
can press ESC or click on Cancel with the mouse. The message box closes, and the
cursor remains where it was before you tried to leave the record.

PAGE DOWN is often useful in list boxes such as the Table Names and File Names
boxes in the table and file management dialog boxes. If there are more tables
available than can be displayed in the Table Names box, for example, you can use
PAGE DOWN to bring up additional table names. PAGE DOWN once takes you to the
last displayed table name; PAGE DOWN again displays additional names that were
previously not visible. If there are no more names available, PAGE DOWN has no
effect.

PAGE UP works in the same way as PAGE DOWN, but always in the opposite
direction. On the Data Entry Form, the same data entry field remains in focus.
The old record in the Data Entry Form—the record you have just left—is saved,
and cannot later be restored to its earlier state with CTRL+Z. If the first record in a
table is displayed, or the first name in a list box, PAGE UP has no effect on the
display. If you try to leave a record that has nothing entered in the Certificate ID
field, a message box appears as described above.

2.2.10  HOME, END, CTRL+HOME, and CTRL+END

HOME and END have effect under two sets of circumstances. The first is when the
focus is on a text entry field that contains text. The field can be a data entry field
on the Data Entry Form or a text entry field elsewhere in the program, such as the 
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Table Name text entry field in a table management dialog box. In this case, HOME

moves the text cursor to the beginning of the field. END moves the cursor
immediately after the last text character. If there is no text in the field, both HOME

and END have no effect.

The second use of HOME and END is when you have selected an item in a list box
such as the Table Names or File Names list boxes. In this case, HOME moves the
highlighting to the first item of the box, no matter which items are currently
displayed. END moves the highlighting to the last item.

In the Data Entry Form, CTRL+HOME moves to the first record of the table. The text
cursor stays in whichever field had the focus, as with PAGE UP. The cursor moves
to the beginning of the field. CTRL+END moves to the last record of the table. Again,
the previously selected field keeps the focus. If there is a text string in the field,
the text cursor appears at the end of it.

Like PAGE UP and PAGE DOWN, CTRL+HOME and CTRL+END save the contents of the old
record, the record you have just left. Therefore, you cannot return to that record
and restore its contents to an earlier state with the Undo Field or Undo Record
options. If you try to leave a record that has nothing entered in the Certificate ID
field, a message box appears as described in Section 2.2.9 “PAGE DOWN and PAGE

UP” on page 39. 

In a list box, CTRL+HOME and CTRL+END behave exactly like HOME and END.

2.2.11  CTRL+C, CTRL+X, and CTRL+V

For Microsoft Windows (and other systems as well), CTRL+C, ctrl+ x, and CTRL+V are
the standard commands for copying, cutting (deleting), and pasting selected
elements. In the SOIC System, you can copy or cut a highlighted block of text to
the Windows clipboard. You can then paste a copy of the text in a new location
with CTRL+V. 

You can copy, cut, and paste within a text box, or between text boxes. You can
copy, cut, and paste between text boxes of different kinds, so for example you
could copy an occupation literal and paste it into a text entry box in the Find
dialog box. You can even cut, copy, and paste between the SOIC System and other
Windows programs. Only text can be cut, copied, and pasted in the SOIC System, 
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however. Cutting or copying replaces and deletes anything already in the clipboard
due to an earlier cut or copy. Elements in the clipboard can be pasted repeatedly.

2.2.12  Field Menu Hot Keys

One key combination is set aside as a shortcut for invoking an option on the Field
pull-down menu. This key combination is:

Option Hot Keys

Undo Field ALT+BACK SPACE

For an explanation of how this command works, see Section 2.5.1 “The Undo Field
Option” on page 79.

2.2.13  Record Menu Hot Keys

Eight keys or combinations of keys are set aside as shortcuts for invoking the
options on the Record pull-down menu. These keys are as follows:

Option Hot Keys

Go to First Record CTRL+HOME

Go to Prior Record PAGE UP

Go to Next Record PAGE DOWN

Go to Last Record CTRL+END

New Record CTRL+INSERT

Find Record... F2

Undo Record CTRL+Z

Delete Record CTRL+D

For a detailed explanation of how the various Record menu commands work, see
Section 2.6 “The Record Menu” on page 82.
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2.2.14  Code Menu Hot Keys

Five combinations of keys are set aside as shortcuts for invoking the options listed
on the Coding pull-down menu. These keys are as follows:

Option Hot Keys

Code Record CTRL+R

Code Table CTRL+T

Code Rest of Table CTRL+O

Code Uncoded CTRL+U

Cancel Coding CTRL+X

For a detailed explanation of how the various Code menu options work, see
Section 2.7 “The Code Menu” on page 88.
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2.3  How the SOIC System Manages Tables and Files

The SOIC System client program was written using the Microsoft Visual Basic
programming language and the Microsoft Access database management system.
SOIC data tables and data files are Access tables and files. As a result, SOIC data
tables, which are contained in the file Userdata.mdb, can be viewed and even
edited using Access. (For safety’s sake, however, this is not recommended.)

A second SOIC System file is TrashCan.mdb. This file contains one
table—TrashCan, the SOIC System Trash Can. Like Userdata.mdb, it is possible to
open TrashCan.mdb  with Access, but this is not recommended.

While Access can be used to look at all SOIC System tables, the SOIC System
itself cannot be used as a generalized Access table viewer. The SOIC System can
open tables that were created using Access, but its ability to manipulate these
tables is limited. 

The SOIC System can also open files created by dBASE, FoxPro, and other
database management systems that save their files in a dBASE-compatible format.
The dBASE format has become an industry standard, and there are hundreds of
applications that can save files in the dBASE format. The term “Xbase” has come
into common use to refer to dBASE compatibility. Xbase files all share the
common three-character extension to their file names. The following are all Xbase
(that is, dBASE-compatible) files:

MYDATA.DBF FOXDATA.DBF 101895DP.DBF

In addition to reading Access tables and Xbase files, the SOIC System can import
text files. 

The fields in Access tables and in Xbase and text files do not need to conform to a
rigid set of guidelines. Fields can be placed in any order. Within limits, fields can
vary in length from one table to another. All lines in a given text file must have the
same length, however.

The SOIC System’s ability to handle a wide variety of external files inevitably
brings with it a degree of complexity. You do not need to concern yourself with
this complexity if you use the SOIC System for data entry, or if you use software
other than the SOIC System to prepare files and tables so that they are in exactly 
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the right format when you open or import them into the SOIC System. If you need
to use the SOIC System to reformat an external file or table, however, these
features are available.

2.3.1  Userdata.mdb and Other Access Files

Access does not store each data table as a separate file. This sets Access apart
from many other database management systems. FoxPro and dBASE, for example,
store every data table as a separate file. When data tables are stored as text files,
the tables are also normally stored one to a file. Access, on the other hand, groups
related data tables together into a single file. It is possible for an Access data file
to contain only a single table, but more commonly a file will contain several tables. 

Because the table names do not represent files, normal DOS or Windows
restrictions on file names do not apply. The only restrictions are those set by
Access itself. A name can be up to 64 characters long. You can use any
combination of letters, numbers, or other keyboard characters for the name, with
a few restrictions. You cannot use the period (.), exclamation point (!), back quote
(`), or brackets ([]). Also, you cannot use leading spaces or control characters.
Table names can contain either capital or lower-case letters, and are stored with
the capitalization you choose. You cannot distinguish two tables from each other
by capitalization, however. Once you have a table named “Mytable” you cannot
create a new one named “mytable.”

It is possible to print out tables from Userdata.mdb using Access. Opening your
working copy of Userdata.mdb with Access, however, can be dangerous. When
opened using Access, a data table is completely editable. It is possible to change
the data or even the table structure in undesirable ways. Unlike word processors
or spreadsheet programs, database management systems like Access immediately
record changes you make to tables and files. You cannot back out of changes by
not saving the file when you exit from the program. Therefore, if you want to use
Access to print Userdata.mdb tables, we recommend that you first make a copy of
Userdata.mdb under a new name. You can do this with the Windows Explorer.
Then print from the copy. 

Alternatively, if Userdata.mdb is large and you only want to print one of several
tables, you can save the tables you want to print to a non-SOIC Access file using
the Save As option. See Section 2.4.5 “The Save As Option” on page 64.
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To print, use the Access Reports option. The Access Reports feature allows you
complete control over the format of a print-out. It is much more powerful than the
Print option available from within the SOIC System. The SOIC System Print option
is a simple convenience, not a full-fledged print formatting program.

2.3.2  How the SOIC System Handles Its Own Tables

The SOIC System opens SOIC System data tables with the Open Table dialog box.
It saves these tables with the Save As dialog box. The Open Table dialog box is the
first thing you see when you invoke the Open option. To display the Access and
Xbase file management dialog boxes, you must first display the SOIC System
dialog box, and then choose Access or one of the Xbase file types using the Data
Source drop-down list. 

For more information on manipulating SOIC System data tables, see the following
sections:

! Section 2.4.1 “The New Option” on page 49.

! Section 2.4.2 “The Open Option” on page 50.

! Section 2.4.4.1 “Save Coded” on page 62.

! Section 2.4.4.2 “Save Uncoded” on page 63.

! Section 2.4.4.3 “Save 998 Codes” on page 64.

! Section 2.4.5 “The Save As Option” on page 64.

! Section 2.4.6 “The Delete Option” on page 67.

A table can be called an SOIC System internal data table if it meets the following
three criteria:

! The table’s structure conforms to the Access data file format.

! The table contains all SOIC System internal fields, including internal system
information fields that are not displayed on the Data Entry Form. (A
definition of the necessary fields is given in Appendix B “SOIC System Data
File Formats” on page 116.) The fields must be of the correct length and
type, but they can be empty.

! The table is stored in the SOIC System file Userdata.mdb.

All three of these criteria must be met.
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2.3.3  How the SOIC System Handles Access Tables

All Access-format tables that do not meet all the criteria outlined in the previous
section are non-SOIC—or external—Access tables. This includes tables created by
the SOIC System itself, and saved to files other than Userdata.mdb. External
Access tables can be opened through the Open option. First invoke the Open Table
box using the Open option. Then choose Access 2000 through the Data Source
drop-down list, and press ENTER. The Open Access file management dialog box
appears. Choose an Access file, and click on Open. The tables in that file are then
displayed in a table management dialog box. For details on how to finish opening
a table, see Section 2.4.2.1 “Opening a Non-SOIC Access Table” on page 52.

Your control over a non-SOIC Access table is limited. You cannot move Access
table records to the TrashCan—all deletions are final. You cannot sort the table.
You cannot import a text file into an open Access table or export an Access table
to a text file. You cannot save coded and uncoded records separately. You cannot
delete an Access table using the SOIC System Delete option. In this version of the
SOIC System, you can add new records. (This was not possible in earlier versions.)

You can open Userdata.mdb as if it were an external Access database file. If you
do, you see the same table names that are normally displayed in the Open Table
dialog box. You can then open Userdata.mdb tables using the SOIC System as if
they were external Access tables. If you do so, however, your rights to manipulate
the table are restricted, just as they are when you open any non-SOIC Access
table.

If you choose the Save As option while an external Access table is open, you have
the option of either saving the table in Userdata.mdb as an SOIC table (thereby
importing it) or saving it under a new name in an external Access .mdb file. If you
want to create a new .mdb file to save the table, Save As lets you do this. For more
information on saving Access tables, see Section 2.4.5 “The Save As Option” on
page 64.

2.3.4  How the SOIC System Handles Xbase Files 

Xbase files are handled very much like non-SOIC Access tables. One obvious
difference is that Xbase tables are always stored one table to a file. There is no
need to first open a database file and then a table. 
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The Open Xbase file management dialog boxes are reached by first invoking the
Open Table dialog box. In that box, choose one of the Xbase file formats from the
Data Source drop-down list, press ENTER, and the appropriate file management
dialog box will appear. For more information on opening Xbase files, see Section
2.4.2.2, “Opening an Xbase File” on page 60.

Your control over Xbase files is limited. You cannot move Xbase records to the
TrashCan—all deletions are final. You cannot sort a file. You cannot import a text
file into an open Xbase file, or export an open Xbase file to a text file. You cannot
save coded and uncoded records separately. You cannot delete an Xbase file using
the SOIC System Delete option. 

In this version of the SOIC System, you can view all the fields of an Xbase file that
are mapped to SOIC System data fields. You can also add new records to an Xbase
file. (These two features were not available in earlier versions.)

If you choose the Save As option while an Xbase file is open, the program opens a
file management dialog box. This box allows you to save the Xbase file in a new
location or under a new name. You cannot save an Xbase file as an SOIC table.
For more information, see Section 2.4.5 “The Save As Option” on page 64.
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Figure 14

2.4  The File Menu

You can access the File pull-down menu by selecting the File item on the menu
bar. To access the File menu from the Data Entry Form, press ALT+F or click on
the File item with the mouse. A pull-down menu appears:

The pull-down menu gives you ten options. You can choose any of them by
clicking on the one you want with the mouse. Alternatively, you can move to the
option you want with DOWN ARROW (presuming you don’t want the first option,
which is already selected), and then choose the option with ENTER.

2.4.1  The New Option

Use the New option to open a new, empty table. If you are using the SOIC System
for data entry, you will first want to open a table with the New option. If you are
importing a text file into the SOIC System, use New to set the name of the table
before you choose the Import option.

You can choose the New option by clicking on File and then New with the mouse
or by pressing ALT+F, N. Alternatively, you can click on the New Table button on
the Button Bar, located below the menus. The New Table dialog box is displayed:
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Figure 15

Figure 16

On opening, the Table Name text entry field is selected, and the cursor is in the
Table Name text entry box. Therefore, you can immediately begin typing in the
name of the new table. The names of existing tables are given in the Table Names
list box. Do not use one of the existing table names—the names are listed in this
dialog box so you will know which names not to use. If you do use an existing
table name, the program displays an error message:

You can only create SOIC System tables with the New option. You cannot use this
option to create, say, a non-SOIC Access table, or an Xbase file. When you are
done, press ENTER or click on OK. To close the dialog box without taking action,
press ESC or click on Cancel.

2.4.2  The Open Option

You can use the Open option to open an existing SOIC System table so that it
appears on the Data Entry Form. Whenever you open a table, the currently open
table is closed and saved.
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Figure 17

You can choose the Open option by clicking on File and then Open with the mouse
or by pressing ALT+F, O. Alternatively, you can click on the Open Table button on
the Button Bar located immediately below the menus. When you choose the Open
option, the program displays the Open Table dialog box:

The text cursor is in the Table Name text entry box, so you can immediately begin
typing in the name of the table that you want to open. When you are done, click
on the OK button with the mouse or press ENTER. The dialog box closes and you
return to the Data Entry Form. The table you have chosen is displayed.

Alternatively, you can choose a table name from the Table Names list box located
immediately below the Table Name text entry field. If you click on one of the
available names with the mouse, the name is highlighted and copied into the
Table Name text entry box. You can then click on OK or press ENTER to return to
the Data Entry Form.

If there are more table names than can be displayed in the Table Names list box at
once, a scroll bar appears on the right-hand side of the box. You can scroll down
the list by clicking on the scroll bar with the mouse. Alternatively, you can move
down the list using keyboard commands. First, move the focus to the list box with
TAB or by clicking on a table name with the mouse. Then use PAGE DOWN or the
arrow keys to move down the list until you have selected the appropriate table
name. If you used TAB to move to the list box, you must use an arrow key to
highlight the appropriate name and copy it to the Table Name field. If you used the 
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mouse, the names you scroll through are already highlighted, and you need only
move the focus to the appropriate name.

For more detail on how to manipulate dialog boxes, see Section 2.1.6 “Dialog
Boxes to Manage Files and Tables” on page 25.

Untitled. You cannot open the untitled table that appears when you open the
SOIC system. Therefore, if you place data in the untitled table and open another
table, the data is effectively lost. Be sure to use the Save As option to save any
information in the untitled table before you do anything that closes it, such as
opening another table or exiting from the system. We describe the Save As option
in Section 2.4.5 on page 64.

References. In addition to opening an SOIC System table, you can also open a
non-SOIC Access table or an Xbase file. We describe how to open such tables and
files in the following sections. For more information on how the SOIC System
handles its own tables, see Section 2.3 “How the SOIC System Manages Tables
and Files” on page 44 and Section 2.3.2 “How the SOIC System Handles its Own
Tables” on page 46.

2.4.2.1  Opening a Non-SOIC Access Table

To open a non-SOIC Access table, you must bring up the Open Access file
management dialog box. This dialog box is available through the Open Table
dialog box. With the mouse, click on the Data Source field. A list of data source
types then appears. Access 2000 is the first type listed, after SOIC. Click on
Access 2000, and the program displays the Open Access file management
dialog box.

Alternatively, you could move the focus to the Data Source element with TAB.
When the name SOIC is highlighted, press DOWN ARROW once to bring up
Access 2000. You can now press ENTER or click on OK to open the Open Access
file management dialog box:
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Figure 18

Access stores tables in database files that have the extension .mdb. Several
tables can be stored in each file. Before you open a table, you must therefore
choose the appropriate database file in which the table is stored.

Using the File Management Dialog Box. If the database file you are looking
for is not in the displayed folder, you can use the controls in the file
management dialog box to locate the file. The field labeled “Look in” at the top
of the box contains a drop-down list box. If you click on the DOWN ARROW

symbol to the right of the box, a list appears that shows the entire folder
structure available through your computer. If you wish to go “up” one level in
the folder structure, you can click on the button located immediately to the
right of the “Look in” field:

To go “down” one level of the folder structure, double-click on one of the folder
icons displayed in the file list box that takes up most of the dialog box. In the
case of Figure 18, that could be either the folder named “1990” or the folder
named “2000.”

SOIC System Files. There are two database names in the file list box when
you first open the Access file management dialog box. These two are SOIC
System files, present whenever you run the SOIC System:
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! Userdata.mdb

! TrashCan.mdb

TrashCan.mdb contains one table—TrashCan. This table is the SOIC System
Trash Can. It is possible to open TrashCan as a non-SOIC Access table, but for
safety’s sake we recommend that you do not do this.

Userdata.mdb is the database that contains all SOIC System data tables. We 
do not recommend that you open this file, either. (In any event, if you try to
open Userdata.mdb as an Access file while an internal SOIC table is displayed,
you receive an error message.) 

You may, however, want to open a file named Userdata.mdb that was created
by another copy of the SOIC System, perhaps at another site. If you are
handling such a file, be careful not to copy it into your active SOIC folder
(usually C:\Program Files\SOIC20). You do not want to overwrite your own
copy of Userdata.mdb! You may want to rename the foreign copy of
Userdata.mdb using the Windows Explorer.

Because SOIC System data tables are by definition also Access tables, you can
open the foreign copy of Userdata.mdb as an Access table. If you do so,
however, your rights to edit and manipulate the table are restricted, just as
they are when you open any non-SOIC Access table.

If the foreign copy of Userdata.mdb was created by the previous version of the
SOIC System—version 1.3—it is not possible to immediately open the file as an
external Access file. This is because SOIC version 1.3 used the Access version
2.0 file format. The current version of SOIC—version 1.5—uses the Access
2000 file format. The two formats are incompatible. To open a copy of
Userdata.mdb created by SOIC version 1.3, first convert the Access 2.0 file into
an Access 2000 file. You can do this from within the SOIC System. (See Section
2.8.5 “The Convert Access Database Option” on page 97.)

Choosing a Table. When the Open Access file management dialog box is first
displayed, the focus is on the File name text entry box at the bottom of the
dialog box. This lets you immediately type in the name of one of the database
files in the default folder. Alternatively, you can click on one of the file names
in the file list box. Now press ENTER or click on the Open button. An Open Table 
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Figure 19

dialog box appears. In the following example, we have opened a copy of
Userdata.mdb created by another copy of the SOIC System:

To open a table, choose its name either with the mouse or by using TAB and the
arrow keys. When you highlight a name in the Table Names list box, the name
is copied into the Table Name text entry field.

You can also type the name directly into the text box. If you type the name of a
file that does not exist into the box, the system displays an error message.

Mapping the Table. The next step is to press ENTER or click on OK. The
program now displays another dialog box:
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Figure 20

The Field Mapping dialog box allows you to open a table even if the field names,
field lengths, or field positions do not match those of an internal SOIC data
table. The mapping feature allows you to identify which fields in the external
Access table match the fields in an SOIC data table. If the external Access table
is formatted so that it already matches an SOIC table—and in this case, the
table is so formatted—you can click on the Internal SOIC option with the
mouse. You can find this option by clicking on the Options button. Figure 21
shows the options available by clicking on the Options button:
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Figure 21

Alternatively, you can move to the Options button with three TABs, highlight the
Internal SOIC option with ENTER, DOWN ARROW, and then close the Options box
with ENTER.

Now close the Field Mapping dialog box by clicking on OK or moving to OK with
TAB and pressing ENTER. You return to the Data Entry Form, where the Access
table is displayed.

How do you map the fields of an external table to the SOIC fields if you do not
know that the table is already in the SOIC format? You do so by using the
controls in the “tab cards” that take up most of the Field Mapping dialog box.
When you first open the dialog box, the tab card Industry/Occupation is
displayed. This tab card contains the four required fields, that is, the four fields
that you must map to open the table. To map a field, click on the data entry
field to the right of the field label. A drop-down list box appears:
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Figure 22

(To open the list without using the mouse, move to the field you want with
repeated use of TAB or SHIFT+TAB, then press ALT+DOWN ARROW.) The drop-down
list contains names of fields in the table you are trying to open. These names
may or may not correspond to the names in an SOIC System table. 

The program only shows names that are at least as large (have at least the
same number of characters) as the SOIC field to which they are to be mapped.
For example, if you open the Occupation Title list, only those fields in the
external Access table that can have 40 or more characters are displayed. If you
open the Occupation Code list, only those fields in the external Access table
that can have three or more characters are displayed. If you must map a table
that contains fields that are too short, you will have to open the table with
Access and change the structure of the table to increase the size of the fields.
You can find the minimum sizes of all SOIC System fields in Appendix B “SOIC
System Data File Formats” on page 116.
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Use the mouse or DOWN ARROW to highlight the name of the field you want to
map to the selected SOIC System field (in the case of Figure 22, Industry Code).
If there are more fields in the Access file than can fit in the drop-down list, a
scroll bar appears on the right-hand side of the list. You may need to use the
scroll bar or PAGE DOWN to find the correct field to map. In the example in
Figure 22, the Access table actually is in the SOIC System data format, and the
field we want is named “icode.” You must scroll down the list box to find icode.

In addition to the four required fields that you must map, you can also map
some or all of the other fields that appear on the SOIC Data Entry Form. You
can find the controls to map these optional fields by clicking on the “tab card”
controls at the top of the Field Mapping dialog box. (To change tab cards
without using the mouse, move to the active tab card with repeated use of TAB

or SHIFT+TAB, and then press LEFT ARROW or RIGHT ARROW.) 

The required fields are on the Industry/Occupation tab card. You can also
display the Identification, Personal Information, and General Information tab
cards. You can map the optional fields in the same way you map the required
fields.

When all four required fields are mapped, and when you have mapped as many
of the optional fields as you want, click on OK or TAB to the OK button and
press ENTER to return to the Data Entry Form. 

If you did not map any of the optional fields, those fields do not appear on the
Data Entry Form. If any of the required fields are not mapped, an error
message appears. If Internal SOIC Mapping is selected, and the program
determines that the external table is not actually in the SOIC System format,
an error message appears.

If you repeatedly open Access tables with the same structure, mapping that
structure over and over again can become tedious. You can therefore save a
mapping scheme that you use repeatedly. To save a scheme, click on the Save
Mapping check box. The next time you open the Access Map Fields dialog box,
you can retrieve the saved mapping scheme by selecting the Saved option,
available by clicking on the Options button. (See Figure 21 on page 57.)
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Figure 23

If you want to open a table using a mapping scheme that is different from both
the Saved and the Internal SOIC schemes, the Clear option allows you to
remove all assigned mappings and design a new scheme from scratch.

For more information on how the SOIC System handles Access tables, see
Section 2.3.3 “How the SOIC System Handles Access Tables” on page 47.

2.4.2.2  Opening an Xbase File

Opening an Xbase file is quite similar to opening an Access table. Because
Xbase programs such as FoxPro and dBASE store each table in its own file,
opening an Xbase file is slightly simpler than opening an Access table. First,
display the Open Table dialog box. Then move the focus to the Data Source
drop-down list. Choose one of the four types of Xbase files, depending on which
program created the file: FoxPro 2.0, FoxPro 2.5, dBASE III, or dBASE IV. If the
application was created by an Xbase program other than these four, use the
dBASE III setting. (The SOIC System is quite forgiving if you use an incorrect
Xbase file setting. It is a good practice, however, to use the correct setting—we
cannot guarantee the results if you do not.)

An Xbase file management dialog box then opens. All of the Xbase boxes look
the same, except for the name in the “Files of type” field:

If the file you are looking for is not in the default folder, you can use the file
management dialog box controls to locate the file.
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To open an Xbase file, highlight the name of the file in the Files list box. This

copies the name into the File Name text entry field. Alternatively, you can type

a name directly into the File Name text entry box. Then press ENTER or click on

OK. If you enter the name of a file that does not exist, the system displays an

error message. If the file name is valid, the Map Fields dialog box appears. This

is essentially the same dialog box that appears after the Open Access Table

dialog box, shown in Figure 20 on page 56, Figure 21 on page 57, and Figure22

on page 58. 

 For an explanation of how to map Xbase files, see the previous section’s

explanation of how to map fields from an external table to SOIC internal fields. 

If the external Xbase file has the same format as an internal SOIC data table,

you can click on the Internal SOIC option, which you can locate by clicking on

the Options button. When you are done, click on OK. You return to the Data

Entry Form with the Xbase file displayed.

If you are creating a new mapping scheme, the program only shows field names

from the Xbase file that are at least as large (have at least the same number of

characters) as the SOIC field to which they are to be mapped. For example, if

you open the Occupation Title drop-down list, only those fields in the Xbase file

that have 40 or more characters are displayed. If you open the Occupation

Code list, only those fields in the Xbase file that have three or more characters

are displayed. (See Figure 22 on page 58.) If you must map a table that

contains fields that are too short, you will have to open the table with FoxPro or

dBase and change the structure of the table to increase the size of the fields.

You can find the minimum sizes of all SOIC System fields in Appendix B “SOIC

System Data File Formats” on page 116. All four required fields (Occupation

Title and Code, Industry Title and Code) must be mapped.

 

For more information on how the SOIC System handles Xbase files, see Section

2.3.4 “How the SOIC System Handles Xbase Files” on page 47.

2.4.3  The Close Option

The close option closes the current table and opens the “untitled” table in the

userdata.mdb database.  If the current table has not been saved it will prompt you

if you want to save the table.
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Figure 24

2.4.4   The Save Option

The Save option groups together three “sub-options.” You can choose the Save
option by clicking on File and then Save with the mouse, or by pressing ALT+F, S.
When you do so, the following submenu opens:

Click on the sub-option that you want with the mouse, or highlight the option
with the arrow keys and press ENTER.

You cannot use the Save option when the “untitled” table is open. (Untitled
appears whenever you open the SOIC System.) This is because the three Save
sub-options close the open table, and open a new one. You cannot re-open
“untitled,” so if you place data in the untitled table and open another table, the
data is effectively lost. Be sure to use the Save As option to save any information
in the untitled table before you do anything that closes it, such as opening
another table or exiting from the system. We describe the Save As option in
Section 2.4.5 on page 64.

2.4.4.1  Save Coded

The Save Coded option opens the Save Coded table management dialog box.
This dialog box can be used to save the coded records in the currently open
table to a new table. Only the coded records are saved. You can use this option
together with the Save Uncoded option to create two new tables containing the
coded and uncoded records from a given data set. This allows you to give
special attention to either group of records. The option is not available if a
non-SOIC Access table or an Xbase file is open. The Save Coded dialog box
looks exactly like the Save As dialog box, except for the title. As with the Save
As option, you can save the table as an SOIC System data table or as an Access
table, but not as an Xbase file.

If you choose a table name that is already in use, the program displays a
message box containing the options Append, Replace, and Cancel. For more on
this message box, see Section 2.4.5 “The Save As Option” on page 64.
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If you use the Save Coded and Save Uncoded options together to create two
tables with complementary data sets, you can use the Save As option to put
the two data sets back together in a single table. Open one of your two partial
tables. Then choose the Save As option. In the Table Name text entry field,
enter the name of the other of the two tables as the table name to which you
want to save. The program displays a message box that asks whether you want
to append, replace, or cancel. Choose append. The program then writes all the
records in the currently open table to the end of the other table. The file
management dialog box closes, and the other table—now containing the
records from both tables—is displayed on the Data Entry Form.

For more information on how this and other dialog boxes work, see Section
2.1.6 “Dialog Boxes to Manage Files and Tables” on page 25.

2.4.4.2  Save Uncoded

The Save Uncoded option opens the Save Uncoded table management dialog
box. This dialog box can be used to save the uncoded records in the currently
open table to a new table. Only the uncoded records are saved. You can use
this option together with the Save Coded option to create two new tables
containing the coded and uncoded records from a given data set. This allows
you to give special attention to either group of records. 

The option is not available if a non-SOIC Access table or an Xbase file is open.
The dialog box looks exactly like the Save As dialog box, except for the title. As
with the Save As option, you can save the table as an SOIC System data table
or as an Access table, but not as an Xbase file.

If you choose a table name that is already in use, the program displays a
message box containing the options Append, Replace, and Cancel. For more on
this message box, see Section 2.4.5 “The Save As Option” on page 64.

If you use the Save Coded and Save Uncoded options together to create two
tables with complementary data sets, you can use the Save As option to put
the two data sets back together in a single table. For details on how to do this,
see the previous section.

For more information on how this and other file management dialog boxes
work, see Section 2.1.6 “Dialog Boxes to Manage Files and Tables” on page 25.
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2.4.4.3  Save 998 Codes

The Save 998 Codes option opens the Save 998 Codes table management dialog
box. This dialog box can be used to save the records coded as 998 in the
currently open table to a new table. Only records coded as 998 for either
industry or occupation are saved. For more information on 998 codes see
Appendix C “The 998 Insufficient Information Code” on page 123. 

The option is not available if a non-SOIC Access table or an Xbase file is open.
The Save 998 Codes dialog box looks exactly like the Save As dialog box, except
for the title. As with the Save As option, you can save the table as an SOIC
System data table or as an Access table, but not as an Xbase file.

If you choose a table name that is already in use, the program displays a
message box containing the options Append, Replace, and Cancel. For more on
this message box, see Section 2.4.5 “The Save As Option” on page 64.

For more information on how this and other file management dialog boxes
work, see Section 2.1.6 “Dialog Boxes to Manage Files and Tables” on page 25.

2.4.5  The Save As Option

The SOIC System saves your data continuously as you work. Each record is saved
the instant you move to another record in any way, or close the table. Even if your
system suffers an abrupt power loss, you should be able to retrieve all data except
for the record on which you were actually working. The SOIC “Save As” feature
exists primarily to create copies of tables under new names.

When you use the Save As dialog boxes to save the currently open table under a
new name, you close and save the table, and open the copy with the new name.
The table or file you closed will continue to contain all the data that existed before
you saved it. (The exception to this rule is the table “untitled,” which is opened
when you start the SOIC System. The untitled table is emptied when you exit.) 

You can choose the Save As option by clicking on File and then Save As with the
mouse or by pressing ALT+F, S. Alternatively, you can click on the Save Table As
button on the Button Bar located immediately under the menus.
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Figure 26

Figure 25

The dialog box that opens when you choose the Save As option depends on what
kind of table or file is active when you choose the option. If an SOIC or Access
table is open, a Save As table management dialog box opens. The Save As dialog
box looks exactly like the Open dialog box, except for the title:

Another difference is that in the Save As dialog box, the Data Source drop-down
list only contains the items SOIC and Access 2000.

If an Xbase file is open, an Open Xbase file management dialog box opens.

When the Save As table management dialog box opens, the text cursor is in the
Table Name text entry box, so you can immediately begin typing in a new table
name. You can also type in an existing table name, or select the name of an
existing table from the Table Names list box. If you select the name of an existing
table, and press ENTER or click on OK, a message box appears:
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Cancel is the default, and is highlighted. If you press ENTER or click on Cancel, the
box closes and you can try another table name. If you want to replace the existing
table with a new one, click on Replace or press TAB, ENTER.

Note that the SOIC System does not allow you to save an SOIC or Access table
under its own name. You must pick a different name, or you will see an error
message. (There is no need to save a table under its own name, because the
program automatically saves the active record in the active table every time you
move to a new record or exit from the program.) 

How Mapping An Access Table Affects the Save As Option. If your Access table
is mapped using the internal SOIC mapping scheme, all fields in the Access table
are mapped. Saving such a table using the Save As option saves all fields and all
information in the fields.

If you have only mapped some of the fields in the Access table, however, saving
the table with the Save As option can lead to a loss of information. Save As only
saves data in fields that have been mapped. The saved table contains all fields in
the SOIC System Data File Format (see Appendix B on page 116), but all fields
that were not mapped are blank. Only the mapped fields contain data. 

If you intend to save a non-SOIC Access table using Save As, therefore, you
should first map all fields that contain any data you want to preserve.

Exporting and Importing Access Tables. Because SOIC System data tables are a
species of Access table, you can use the Save As dialog box to transfer an SOIC
System data table to a database other than Userdata.mdb. Use the Data Source
control to open an Access 2000 file management dialog box, and then choose an
Access .MDB file. When the Access 2000 Open Table dialog box is displayed, enter
a table name to save the active SOIC table, and click on OK or press ENTER. Note
that the Data Entry Form continues to display the SOIC System version of the
table you just saved—not the Access version. If you want to open the Access
version, you must use the Open option to open the new table.

It is also possible to turn an external Access table into an SOIC System data
table—to import that table, in effect. This is useful because at some point you may
want to import tables created by another copy of the SOIC System, at another site.
You should only import Access tables if you know that they are already in the
standard SOIC System data format. If you attempt to import a non-conforming 
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Figure 27

table, the system will report that the table is incorrectly formatted when you try to 
open it through the Open Table dialog box.

To import an Access table, first open it as an Access table. (See the previous
section for details on the Open option.) In the Field Mapping dialog box, select the
Internal SOIC mapping option. When the Access table is displayed on the Data
Entry Form, use the Save As option to save it to the database Userdata.mdb. The
table displayed on the Data Entry Form is the new SOIC table—options such as
Save, Import, Export, and Sort are now available through the menu system.

Xbase Files. It is not possible to save an open Xbase file as an SOIC table. If you
want to import an Xbase file into Userdata.mdb, use FoxPro or dBase to save the
file as a text file, and then use the SOIC Import option to bring it into the system.

It is possible to save an open Xbase file under the same file name, overwriting the
old file.

2.4.6  The Delete Option

The Delete option allows you to permanently delete an SOIC System data table.
You can choose the Delete option by clicking on File and then Delete with the
mouse, or by pressing ALT+F, D. The Delete Table dialog box then opens:
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The text cursor is in the Table Name text entry box, so you can immediately begin
typing in the name of the table you want to delete. Alternatively, you can choose a
table name from the names displayed in the Table Names list box. When you are
done entering the table name, press ENTER or click on OK. A message box appears,
asking you to confirm your deletion. You cannot delete the currently open table. If
you try to do so, the program displays an error message.

Once a table is deleted, it cannot be recovered. Obviously, the Delete option can be
very dangerous. Use it with care. You may want to back up the file Userdata.mdb
before performing any deletions. An alternate plan would be to save important
tables to an Access database located on a floppy disk.

If you use floppy diskettes for backup, consider that Userdata.mdb will in many
cases be too large to fit on a single diskette. You will therefore need to back up
Userdata.mdb using software that can place a single file on multiple diskettes.
Software written to back up or condense files, such as Microsoft Backup or
Winzip, can do this. Simple file copying using Windows Explorer cannot place one
file on multiple diskettes.

2.4.7  The Import Option

You can use the Import Text File dialog box to translate an existing data file
rom a text format to the format used by the SOIC System. After it is translated, 
the imported data is appended to whichever table is currently open. Therefore, 
you should not use the Import option when the currently open table contains 
records that you want to preserve as a separate table. Before importing, first 
close such a table and use the New option to create a new, empty table. For
more on the New option, see Section 2.4.1 “The New Option” on page 49.

You can choose the Import option by clicking on File and then Import with the
mouse, or by pressing ALT+F, I. Alternatively, you can click on the Import button
on the Button Bar, located immediately below the menus.

The Import Text File dialog box is a generic Windows file management dialog box,
and looks much like the Open Xbase File dialog box, except for the title and the
contents of the Files of Type field:
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Figure 28

To be imported into the SOIC System successfully, a text file must have a format
that the SOIC System can understand. The SOIC System expects a text file in
which each record consists of a single line, ending with a carriage return. The
individual fields of each record are in a “columnar” format. That is, each field is
identified by its location on the record line, in spaces. For example, the first field,
Local ID, may take up spaces 1 through 4 of the line. The second field, Temporary
ID, may take up spaces 5 through 10. Autopsy may be in space 211. 

As we will explain shortly, text files do not need to have fields in any particular
order, and fields may vary in length from one file to another. The exact location of
the fields within the columnar format, in other words, can vary. The files must be
formatted in a columnar format, however—the SOIC System cannot import data
from a text file when the fields vary in length from one record to another, or are
delimited by characters such as the tab symbol or commas. For a complete
description of the SOIC System standard text file format, see Appendix B “The
SOIC System Data File Formats” on page 116.

You can begin importing a text file from the currently active folder by typing the
name of the file in the File Name field. You can also choose a file name from the
File Names list box. When you have entered the file name, press ENTER or click on
the OK button.

If you type in the name of a file that does not exist, Windows displays an error
message. If the text file name you specified does exist, the SOIC System displays a
new dialog box:
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Figure 29

The Import Mapping dialog box allows you to import text files even when the text
files are not in the SOIC standard text file format. This dialog box allows you to
specify the location of each field in the text file from which you plan to import.

When the SOIC System is first installed, the fields displayed in the Fields For
Import list box on the right-hand side of the dialog box are the fields of a standard
SOIC text file. (This can be changed by the user, as we explain below.) If you know
that the text file from which you are importing is in the standard format, you can
simply press ENTER or click on OK. You are then returned to the Data Entry Form,
where the data from the text file is appended to the open SOIC data file.

If you know that the text file has a field structure different from that of the
standard format, you can use the controls in the Import Mapping dialog box to
describe the text file. (Refer to the illustration of the dialog box in Figure 29 as we
discuss the controls.)



  The SOIC System User’s Manual

Page 71

First, highlight a field name by clicking on it with the mouse, or by using TAB and
the arrow keys. The name appears in the Field Name display box, located below
the Fields For Import list. (You cannot edit the Field Name display box, but it does
serve to remind you which field is selected.) You can now use the Size text entry
box to change the number of characters in the field. You can type a new number
into the text box, or use the up and down controls at the right-hand side of the
box to change the number. You cannot make the number of characters in a field
greater than the number of characters allowed in the SOIC standard text file
format. 

You can use the Remove button to move fields to the Fields Not For Import list
box. If your text file does not contain some of the fields that the SOIC System
supports, you must move these fields to the Fields Not For Import list box before
the import actually takes place. 

The Fields Not For Import list box is also highly useful if the fields in the text file
are not in the same order as the fields in the SOIC standard format. You can
change the order of fields by moving some or all of them to the Fields Not For
Import list, and then moving them back to the Fields For Import list. Probably the
simplest way of changing the order of fields is to use the Remove All button to
move all the fields to the Fields Not For Import list. You can then move them back
to the Fields For Import list one by one, in the desired order. To move a field name
from one list to the other, first highlight the name, and then click on the Add or
the Remove button.

There are quicker, if more complicated, ways to move names from one list to the
other—you can move field names in groups. Highlight one name, and then hold
down ctrl while you click on additional names. This allows you to select multiple
names regardless of whether they follow each other on the list. You can highlight
one name and hold down SHIFT while you click on another name. This highlights
both names and every name in between.

If one or more names on Fields For Import are highlighted when you move new
names onto the list from Fields Not For Import, the new names are inserted
immediately after the last highlighted name. If no names are highlighted on Fields
to Import, the new names go to the end of the list. You can change where the new
names go by clicking on the “Insert Before” radio button. With this button
selected, new names are added before the highlighted names in the list, rather 
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than after. If the Insert Before radio button has already been selected, you can
make new names go after highlighted names by selecting Insert After.

The Fields For Import list automatically begins each field immediately after the
field before it. As you change the size of fields, or their order, the starting location
of each field is automatically adjusted. You can see where each field begins by
looking at the “Start” column in the Fields For Import list box.

Say the text file allows 20 characters for Father’s Surname. The SOIC System
allows only 19 for this field, so the next field after Father’s Surname may begin
one character too early. What should you do? The answer: leave the width of
Father’s Surname set at 19, but pad the list by putting the <blank> field name
between Father’s Surname and the following field. The <blank> field name is
located in the Fields Not For Import list box. The <blank> field is always one
character wide when it is copied to the Fields For Import list, but afterwards you
can edit the width. 

You can add an unlimited number of copies of <blank> to the Fields For Import
list box—unlike the real file names, <blank> is not deleted from the Fields Not For
Import list when you add it to the Fields For Import list. The <blank> field name
can also be used to replace a field in the text file that does not have an SOIC
System equivalent, and therefore cannot be imported.

Changing the order of field names quickly using the two list boxes can seem a
little like a game! Fortunately, there are a near-infinite number of possible
solutions, and you will quickly find one that works well for you. Just remember
the object of the exercise: you want to describe the text file from which you are
importing in such a way that the SOIC System can understand its contents. If
First Name, for example, is the very first field in the text file from which you are
importing, it must be the first field in Fields For Import, and begin in column 1. If
the field Date of Death begins in column 100 in the text file, it must be listed as
beginning in column 100 in the Fields For Import list box.

The imported data must contain the four core fields: Occupation Title, Occupation
Code, Industry Title, and Industry Code. These fields may be empty, but they
must exist.

Because import mapping can be complicated, and because you may want to
repeatedly import files that have identical structures, the Import Mapping dialog 
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box contains a check box that allows you to save the mapping scheme you have
designed. To save your scheme, click on the Save Mapping check box with the
mouse. Alternatively, move to the check box with TAB and press SPACE BAR. 

The next time you open the Import Mapping dialog box, your mapping scheme is
displayed in the Fields For Import list box instead of the SOIC default scheme. If
you do not need to modify your saved scheme, you can proceed by clicking on OK
or pressing ENTER. 

The Options button allows you to retrieve the standard SOIC text file format
(System Defaults) if the user-defined scheme is currently displayed in the Fields
For Import list box. You can switch to the saved, user-defined scheme (Saved
Format) if the standard SOIC format is currently displayed. Having both options
can be useful if some of the files you import are in the standard format and others
are in the non-standard format that you have saved. System Defaults can also be
used during the design of a mapping scheme if you do not like what you have
come up with, and want to start over.

The Test button allows you to examine the appearance of a mapping scheme. A
box similar to the following example appears:
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Figure 30

The Import Test box allows you to see how the data from the first record of the text
file will be organized when the import process is complete. If any field from the
text file appears to be broken up—that is, distributed across two or more of the
cells in the Value column—your mapping scheme will have to be revised. If all
cells in the Value column appear to contain reasonable values, you can now
proceed to finish the import.

Return to the Import Mapping dialog box and click on OK or press ENTER. If
everything has gone right, and the data in the text file is imported successfully,
the dialog box closes and you return to the Data Entry Form. The data you have
imported is visible, and the name of the file you imported the data into is
displayed above the form.
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2.4.8  The Export Option

The Export option allows you to save the table you are working on as a text file. It
can then be imported into other software programs for further processing. You
may want to manipulate a text file using a database management system or a
spreadsheet. You can also edit such a file with a word processing program if you
want to make use of the word processor’s extensive formatting capabilities. 

You can choose the Export option by clicking on File and then Export with the
mouse, or by pressing ALT+F, E. Alternatively, you can click on the Export button
on the Button Bar, which is located immediately below the menus. When you do
so, the program opens the Export Text File dialog box, which looks exactly like the
Import Text File dialog box except for the title. (See Figure 28 on page 69.) This
dialog box allows you to choose a name for the file to which you are exporting. The
standard extension for text files is .TXT, but you are not limited to using this
extension. If you choose an existing file name, a message box asks you if you want
to replace the file or cancel.

When you enter a file name and press ENTER or click on OK, the Export Mapping
dialog box opens. This dialog box is almost identical to the Import Mapping dialog
box (see Figure 29 on page 70)—the title of the box is different, and there is no
Test option.

If you want your exported text file to have the standard SOIC text file format, you
can simply press ENTER or click on OK, and the export will proceed. For a complete
description of the SOIC System standard text file format, see Appendix B “SOIC
System Data File Formats” on page 116. Note that a number of fields at the end of
an SOIC internal data table are not displayed on the Data Entry Form and are not
exported. These fields are used by the SOIC System itself to administer its tables.

If you want to export a text file that has a structure different from the standard
SOIC text file format, you can use the controls in the Export Mapping dialog box
to establish the structure of the exported file. These controls operate in the same
way as the controls in the Import Mapping dialog box, described in the previous
section. 

As with the Import Mapping dialog box, you can save a frequently used mapping
scheme for later reuse. If you do so, your saved scheme will appear whenever you 
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Figure 31

open the Export Mapping dialog box. You can then choose between the saved
scheme and the standard SOIC scheme.

2.4.9  The Print Option

The SOIC System Print option allows you to print selected fields from the data
table displayed in the Data Entry Form. The Print option does not allow you to
print all of the fields in the records—it can only print the ID fields and the core
coding fields. You can print all records, just coded records, just uncoded records,
or just records assigned a code of 998. If you choose to print records coded as
998, SOIC will print all records assigned this code for either industry or
occupation. (For an explanation of 998 codes, see Appendix C “The 998
Insufficient Information Code” on page 123.)

You can choose the Print option by clicking on File and then Print with the mouse
or by pressing ALT+F, P. Alternatively, you can click on the Print button on the
Button Bar located immediately under the menus. Choosing the Print option
brings up the following dialog box:

You can choose the fields you want to print with the check boxes in the center
column of the dialog box. You can choose which records to print with the radio
buttons in the left-most column in the box.
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Figure 32

The records print to the default Windows printer. If you have more than one
available printer, you can change printers with the Advanced button:

The Print Setup dialog box, shown above, also allows you to change the paper size
and source, and to switch between portrait and landscape output. Depending on
your printer, a Properties button may provide additional advanced printer control
settings.

The Fonts button in the Print Records dialog box (see Figure 31) opens the Font
dialog box. This box allows you to change the font and point size of your print-out:
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Figure 33

There are ways to print an SOIC table if the options available through the SOIC
Print option are not sufficient to provide the results you need. If you want to print
all fields in the records, or format your print job, you can export the table to a text
file and manipulate the file with a word processing program. Alternatively, if you
have Microsoft Access, you can open the table (or more safely—a copy of the table)
directly and print it using Access’s form design capabilities. 

2.4.10  The Exit Option

The Exit option allows you to leave the SOIC System. On leaving, you return to
Microsoft Windows. You can choose the Exit option by clicking on File and then
Exit with the mouse, by pressing ALT+F4, or by pressing ALT+F, X. 

When you start the SOIC System, the program will open the “untitled” table from
Userdata.mdb on start-up. Remember that the untitled table is always emptied
when you leave the SOIC System. If you have entered any data into the untitled
table and you wish to save your data, you must save the table under another
name before exiting. For details on the Save As command, see Section 2.4.5 “The
Save As Option” on page 64.
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Figure 34

2.5  The Field Menu

You can access the Field pull-down menu by selecting the Field item on the menu
bar. To access the Field menu from the Data Entry Form, press ALT+I or click on
the Field item with the mouse. A pull-down menu appears:

The pull-down menu gives you two options. You can choose either of them by
clicking on the one you want with your mouse. Alternatively, you can move to the
option you want with the arrow keys, and then choose the option with ENTER. You
can also press the underlined character key. For example, U chooses Undo Field.

2.5.1  The Undo Field Option

The Undo Field option removes any changes you have made to a data entry field
on the current record of the Data Entry Form, and restores the field to a previous
state. Undo Field only works if you have not moved to a different record, coded the
record, or saved your table since you made the changes. Once you move to a
different record, code the record, or save your table, the changes to the field
become permanent, and the previous state is lost. 

To choose the Undo Field option, first move the text cursor to the field you want to
restore. You can then press ALT+BACK SPACE. Alternatively, you can click on Edit
and then Undo Field with the mouse, or press ALT+I, U.

2.5.2  The Suppress Fields Option

The Suppress Fields option allows you to suppress the display of one or more
fields that normally appear on the Data Entry Form. Display of the four core
coding fields cannot be suppressed. (These fields are Industry Title, Occupation
Title, Industry Code, and Occupation Code.) With all possible fields suppressed,
the Data Entry Form looks like this:
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Figure 35

To choose the Suppress Fields option, click on Field and then Suppress with the
mouse. Alternatively, you can type ALT+I, S. The Field Suppress dialog box opens:
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Figure 36

To suppress a single field, click on its name or check box with the mouse and then
click on OK. Alternatively, press TAB to move the focus through the list of names to
the name you want, and press SPACE BAR. Then press ENTER. 

You can suppress a number of fields by clearing checks from multiple check boxes
before leaving the dialog box.

To close the dialog box without taking action, press ESC or click on Cancel. If you
have previously suppressed the display of one or more fields, you can use the
Restore button to restore the display of all fields.

The effects of Suppress Fields are canceled when you quit the SOIC System or
open a new SOIC table, Access table, or Xbase file. The system reverts to
displaying all available fields.
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Figure 37

2.6  The Record Menu

You can access the Record pull-down menu by selecting the Record item on the
menu bar. To access the Record menu from the Data Entry Form, press ALT+R or
click on the Record item with the mouse. A pull-down menu appears:

The pull-down menu gives you eight options. You can choose any one of them by
clicking on the one you want with your mouse. Alternatively, you can move to the
option you want with the arrow keys, and then choose the option with ENTER. You
can also press the underlined character key. For example, u chooses Undo
Record.

2.6.1  The First Record Option

This option displays the first record in the open table. It also saves the record you
have just left, so it cannot be restored later with ALT+BACK SPACE or CTRL+Z.

The First Record option is equivalent to pressing CTRL+HOME or the left-most
VCR-control button (the First Record button) on the Button Bar. You can therefore
go to the first record with either CTRL+HOME or ALT+R, R.

2.6.2  The Prior Record Option

This option displays the record in the open table that immediately precedes the
displayed record. It also saves the displayed record, that is, the record you have
just left, so it cannot be restored later with ALT+BACK SPACE or CTRL+Z.

The Prior Record option is equivalent to pressing PAGE UP or the second
VCR-control button (the Prior Record button) on the Button Bar. You can
therefore go to the prior record with either PAGE UP or ALT+R, P.
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2.6.3  The Next Record Option

This option displays the record in the open table that immediately follows the
displayed record. It also saves the displayed record, that is, the record you have
just left, so it cannot be restored later with ALT+BACK SPACE or CTRL+Z.

The Next Record option is equivalent to pressing PAGE DOWN or the third
VCR-control button (the Next Record button) on the Button Bar. You can therefore
go to the next record with either PAGE DOWN or ALT+R, X.

2.6.4  The Last Record Option

This option displays the last record in the open table. It also saves the record you
have just left, so it cannot be restored later with ALT+BACK SPACE or CTRL+Z.

The Last Record option is equivalent to pressing CTRL+END or the right-most
VCR-control button (the Last Record button) on the Button Bar. You can therefore
go to the last record with either CTRL+END or ALT+R, L.

2.6.5  The New Record Option

This option creates a new, empty record at the end of the open table. You move to
that record, with the cursor in the Local ID field. The command also saves the
record you have just left.

The New Record option is equivalent to pressing CTRL+INSERT. You can therefore
create a new record with either CTRL+INSERT or ALT+R, N.

2.6.6  The Find Record Option

The Find Record option allows you to find a record in the currently open table that
meets one of a number of search criteria. You can choose Find by clicking on
Record and then Find with the mouse, by pressing F2, or by pressing ALT+R, F. 

When you choose the Find option, the program displays a dialog box:
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Figure 38

Figure 39

Figure 40

The Find dialog box allows you to search for records by any of nine different
criteria. To search for records using a specific criteria, click on the darkened
criteria field or press ALT+DOWN ARROW. A drop-down list appears:

To select a Find criteria, click on one of the list items or press DOWN ARROW. As an
example, you can search for a specific record number. When you choose Record
Number, the drop-down list closes and a data entry box appears to the right of the
criteria field:

Type the record number you want into the text entry box to the right of the Record
Number field, and then press ENTER or click on Find First. (Find Next is grayed out
because it is not relevant when you are searching for a specific record number.)
You can also use the “spin button” next to the Record Number text box to set the
record number.

Find First begins searching with the first record in the table. It finds the first
instance of your target criteria in the table. Find Next begins searching with the 
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record immediately following the current record. In other words, it only finds
records that appear in the remaining part of the table. If you want to close the
message box, click on Cancel or press ESC. 

If you search for records coded 998, the Find option searches for records assigned
a code of 998 for either industry or occupation. (For more information on 998
codes, see Appendix C “The 998 Insufficient Information Code” on page 123.)

The SOIC Find option supports “wild card” searches. That is, the text you type
into the text entry box to the right of the criteria field can contain an asterisk (*)
that stands for any combination of characters. For example, if you type “farm*”
into the box, the program will find “farm,” “farmer,” and “farming.”

Find can search non-SOIC Access tables and Xbase files as well as SOIC data
files. When Find searches Xbase files, the search is “case-sensitive”—that is, Find
distinguishes between upper and lower case. Typing in “Farmer” will not find
“FARMER.”

When searching for industry or occupation titles or codes, your search may have
many results. You may want to page through the results and examine each
record. You can do this while the Find dialog box is open by repeatedly clicking on
the Find Next button. When you do this, however, the Find dialog box may
obscure parts of the Data Entry Form that you want to examine. To address this
problem, the SOIC System allows you to page through the results of the most
recent search with the Find dialog box closed. Just close the dialog box with ESC

or in any other way. Then press F3 repeatedly. After each key-press, the program
displays the next Find result.

If you try to find a record that does not exist, the program displays an error
message. If you search data fields and there is no match for your search string,
the message is: “No records found.” If you search for a specific record number and
there is no such record number that large, the message is: “The Record Number is
too large.”

When searching for a particular string, bear in mind that some data, especially
data that has been imported into the SOIC System, may contain leading blanks.
That is, an instance of Occupation could be stored as “_Typist” rather than as
“Typist_” (the underline character here represents the blank). When this is the 
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case, you must enter the leading blanks to find the search string, or put an
asterisk before your text.

Find saves the record that is active when you open the Find option, so that record
can no longer be restored to a previous state with Undo Field or Undo Record.
This happens regardless of whether or not you move to another record using Find. 

2.6.7  The Undo Record Option

The Undo Record option removes changes you have made to all the fields on the
current record of the Data Entry Form, restoring the record to a previous state.
Undo Record is equivalent to executing Undo Field on every field of the record.
Undo Record only works if you have not saved your table since you made the
changes, coded the record, or moved to a different record. Once you move to a
different record, code the record, or save your table, the changes to the record
become permanent, and the previous state is lost. 

To choose the Undo Record option, you can click on Record and then Undo with
the mouse, press CTRL+Z, or press ALT+R, U. As you become more experienced with
the program, you will find that pressing CTRL+Z is usually the most convenient way
to execute the Undo Record option. CTRL+Z is a Windows standard for “undo,” and
has the same effect in many Windows software applications. The option is listed
on the Edit menu in part to remind you that the option exists, and to give you a
place to look if you forget how to use it.

2.6.8  The Delete Record Option

You can choose Delete Record by clicking on Record and then Delete with the
mouse, by pressing CTRL+D, or by pressing ALT+R, D.

The Delete Record option allows you to eliminate the currently active record in a
SOIC table by transferring it to the Trash Can. Once the record is removed, any
records that follow it in the table are renumbered so that there are no missing
record numbers. If the table only contains one record, you cannot delete it. If you
try, you see an error message. All tables must contain at least one record.

Records placed in the Trash Can can be restored to the currently open table or
purged completely. For more information on how to use the Trash Can, see
Section 2.8.6 “The Trash Can Option” on page 100.
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You can also delete the currently active record in an open Access table or Xbase
file. If you do so, however, the record is not placed in the Trash Can. A warning
message appears that states: “If you delete this message you cannot restore it.” To
proceed, click on the OK button or press ENTER. To keep the record, press on the
Cancel button or press ESC.
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Figure 42

Figure 41

2.7  The Code Menu

Coding industry and occupation titles is the core purpose of the SOIC System. The
Code menu gives you the options to do just that. 

You can access the Code pull-down menu by selecting the Code item from the
menu bar. To access the Coding menu from the Data Entry Form, press ALT+C or
click on the Coding item with the mouse. A pull-down menu appears:

The pull-down menu gives you four active options (and one that is grayed out).
You can choose any of the available options by clicking on the one you want with
your mouse. Alternatively, you can move to the option you want with DOWN ARROW

(presuming you don’t want the first option, which is already selected), and then
choose the option with ENTER. 

If you open the Code pull-down menu while you are coding a table, the menu
looks like this:

You cannot choose one of the coding options, because coding is already underway.
You can cancel the ongoing coding, however, with the Cancel option.

2.7.1  The Code Record Option

The Code Record option allows you to generate industry and occupation codes one
record at a time. This option takes the occupation title from the Occupation field, 
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Figure 43

processes the text, and places an occupation code in the occupation Code field.
The option performs a similar operation to generate an industry code and
category. The following figure shows an example of a coded record:

Note the “balloon” located immediately below the industry Code field that says
“department stores.” This is a definition of the code 591. You can see definition
balloons for industry and occupation codes by placing the mouse pointer in a
Code field and waiting about half a second. The definition balloons only appear
when there is actually a code in the Code field. You cannot display them by using
the keyboard.

To choose the Code Record option, click on Code and then Record with the mouse,
press CTRL+R, or press ALT+C, R. Alternatively, you can click on the Code Record
button on the Button Bar below the menus.
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With the current version of the SOIC System, coding a single record should be
almost instantaneous.

Code Record saves the record, and it cannot be restored to an earlier state with
Undo Field or Undo Record.

2.7.2  The Code Table Option

The Code Table option allows you to generate industry and occupation codes for
all the records in a table at once. Coding a large table can take some time, so
during coding, the program displays a Coding Progress bar on the left-hand side of
the Status Bar:

You can interrupt the coding process by clicking on the Stop button on the Button
Bar or pressing CTRL+X. Whether you interrupt the coding or let the coding
proceed to its conclusion, the Data Entry Form continues to display the record
that was displayed when you began coding.

To choose the Code Table option, click on Code and then Table with the mouse,
press CTRL+T, or press ALT+C, T. Alternatively, you can click on the Code Table
button on the Button Bar located immediately below the menus.

Code Table saves each record in the table as it is coded, and therefore coded
records cannot be restored to an earlier state with Undo Field or Undo Record.

2.7.3  The Code Rest of Table Option

To choose the Code Rest of Table option, click on Coding and then Code Rest of
Table with the mouse, press CTRL+O, or press ALT+C, O.

Code Rest of Table begins coding with the record currently displayed on the Data
Entry Form, and proceeds through to the last record in the table. If the number of
records remaining in the table is large, coding can take some time. Therefore,
Code Rest of Table displays a Coding Progress bar on the Status Bar, as shown in
the previous section.
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You can interrupt the coding process with CTRL+X or by clicking on the Stop
button on the Button Bar. Whether you interrupt the coding or let the coding
proceed to its conclusion, the Data Entry Form continues to display the record
that was displayed when you began coding.

Code Rest of Table saves all the records that it attempts to code, and therefore
none of them can be restored to an earlier state with Undo Field or Undo Record.

Code Rest of Table can be useful if you earlier interrupted a coding session using
Stop or CTRL+X. Code Rest of Table allows you to finish the job without recoding
the first part of the table. 

2.7.4  The Code Uncoded Option

To choose the Code Uncoded option, click on Code and then Uncoded with the
mouse, press CTRL+U, or press ALT+C, U.

Code Uncoded attempts to code all records that do not have an occupation or
industry code assigned, no matter where they appear in the table. If the number of
uncoded records remaining in the table is large, coding can take some time.
Therefore, Code Uncoded displays a Coding Progress bar on the Status Bar, as
shown in Section 2.7.2 “The Code Table Option” on page 90.

You can interrupt the coding process with CTRL+X or by clicking on the Stop
button on the Button Bar. Whether you interrupt the coding or let the coding
proceed to its conclusion, the Data Entry Form continues to display the record
that was displayed when you began coding.

Code Uncoded saves all the records that it attempts to code, and therefore none of
them can be restored to an earlier state with Undo Field or Undo Record.

2.7.5  The Cancel Option

To interrupt coding, you can choose the Cancel option by clicking on Code and
then Cancel, press CTRL+X, press ALT+C, C, or click on the Stop (“Cancel Coding”)
button on the Button Bar. The Cancel option only takes effect when coding is
actually in progress. At other times, the Cancel option on the Code menu and the
Stop button on the Button Bar are grayed out. When coding is not taking place,
CTRL+X has no effect on the program.
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Figure 45

Figure 44

2.8  The Tools Menu

You can access the Tools pull-down menu by selecting the Tools item from the
menu bar. To access the Tools menu from the Data Entry Form, press ALT+T or
click on the Tools item with the mouse. A pull-down menu appears:

The pull-down menu gives you six options. You can choose any one of them by
clicking on the one you want with your mouse. Alternatively, you can move to the
option you want with the arrow keys and then choose the option with ENTER.

2.8.1  The Settings Option

The Settings dialog box lets you change two features of the SOIC System. You
can change whether the program requires data in the Certificate ID field and 
whether the program displays system time on the Status Bar:

ID Field Required. The SOIC System can be configured to require that each
record have an entry in the Certificate ID field of the Data Entry Form. If this field
is blank, and you move to another record, a message box appears:
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Figure 46

This message box appears if you press PAGE DOWN, PAGE UP, CTRL+HOME, or
CTRL+END, or if you try to create a new record with CTRL+INSERT. It appears if you
try to exercise any of the coding options. It also appears if you move off a record
through the New, Open, Save, Save As, Import, Export, Print, Exit, Find, Sort,
Coding Stats, or Convert Access Database options. (You can send the record to the
Trash Can without seeing the message.) The message box contains two buttons:
OK and Cancel. OK is the default and is highlighted. If you press ENTER or click on
OK with the mouse, the message box closes and you complete your move to the
new record. 

If you want to enter an ID before moving off the current record, click on Cancel
with the mouse. Alternatively, you can move the highlighting to Cancel using TAB

or RIGHT ARROW and then press ENTER. The message box closes, and you return to
the current record. You can move to the Certificate ID field and enter some data. 

If “ID Field Required” is turned on, and you do not want to be bothered by
requests to enter an ID, you can turn the messages off through the Settings dialog
box. To open the box, press ALT+T, S or click on Tools and then Settings. The
Settings dialog box opens. It contains a highlighted check box labeled “ID Field
Required,” which is checked with an X, as shown in Figure 45 above.

To remove the X, press SPACE BAR or click on the X with the mouse. If you have
disabled the messages earlier and want to restore them, SPACE BAR or a mouse
click will place an X in an empty check box. To close the dialog box, press ENTER

or click on OK. Pressing ESC or clicking on Cancel closes the box without changing
the setting.

ID Field Required is turned off the first time you install and run the SOIC System.
Thereafter, ID Field Required stays the way you have set it, even if you rerun the
SOIC System or open a new table.
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Figure 47

Figure 48

Display System Time. This check box simply determines whether or not the time
of day, as known to your computer, is displayed in the right-most end of the
Status Bar. There are not many reasons to turn the time display off. One of the
few would be if your computer were set to an incorrect time, and you were unable
conveniently to reset it to the correct time.

2.8.2  The Sort Option

The Sort option allows you to sort the records in an SOIC data table using any of
the fields on the Data Entry Form as criteria. You can choose the Sort option by
clicking on Tools and then Sort with the mouse, or by pressing ALT+T, O. The Sort
By dialog box then opens:

If you choose only a primary criterion, the program sorts only on the primary field.
To choose a primary criterion, click on the Primary data entry box or on the DOWN

ARROW symbol immediately to the right of the box. Alternatively, press ALT+DOWN

ARROW. A drop-down list is displayed:

You can highlight the criterion you want by clicking on it with the mouse or
pressing DOWN ARROW (repeatedly if necessary). You can display additional criteria
by pressing PAGE DOWN or by using the scroll bar on the right-hand side of the 
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drop-down list. After you have chosen a sort criterion, click on the OK button or
press ENTER.

You have the option of choosing a secondary sort criterion as well as a primary
one. If you do so, the program sorts all records on the primary criterion, and when
two or more records have the same primary criterion, sorts them on the secondary
criterion. For example, if Last Name is the primary criterion and First Name is the
secondary one, all records are sorted by the last name, and all records with the
same last name are then sorted by the first name:

1. Benjamin Harrison
2. William Harrison
3. Franklin Roosevelt
4. Theodore Roosevelt

Sort saves the active record, so no records can be restored to an earlier state with
Undo Field or Undo Record. As part of the sorting, all records are renumbered.

You cannot sort non-SOIC Access tables or Xbase files.

2.8.3  The Show Coding Stats Option

The Coding Stats window shows the coding statistics for the records in the
currently open table. The total number of records is displayed in the top left
corner of the window. The coding statistics are displayed in the lower portion of
the window. The number of records that have industry codes assigned, the
number that have occupation codes assigned, and the number that have both
codes assigned are shown along with their corresponding percentages. Statistics
for records coded 998 (insufficient information) are counted into the overall
throughput. (For more information on 998 codes, see Appendix C “The 998
Insufficient Information Code” on page 123.)

An example of the Coding Stats window is shown in the following figure:
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Figure 49

The bar graph in the upper portion of the window is a graphical representation of
the coding statistics.

You can display the coding statistics by pressing ALT+T, C or by clicking on Tools
and then Coding Stats with the mouse. You can print the statistics (including the
bar graph) by clicking on the Print button. When you are done viewing the
statistics, close the message box by clicking on the OK button.

2.8.4  The Database Information Option

The Database Information option provides information about the currently active
database file and table. (If an Xbase file is open, the table is equivalent to the file.)
You can display the Database Information window by clicking on Tools and then
Database Information, clicking on the question-mark button on the Button Bar 
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Figure 50

(the Database Information button) or pressing ALT+T, D. A window opens that is
similar to the following example:

This display shows that the currently active table is Demo, which is stored in the
file C:\PROGRA~1\SOIC2\Userdata.MDB. The last line, labeled Default: Path,
shows where the SOIC System expects to find its Userdata.mdb database.

Even though the Database Information window looks like a dialog box, you cannot
select fields in the box or edit the displayed information. The only action you can
take is to close the box with ENTER or ALT+F4; by clicking on the OK button; or by
clicking on the X button in the far upper-right of any Windows box.

2.8.5  The Convert Access Database Option

Microsoft has released several generations of the Access database management
system. Unfortunately, successive versions of Access do not share a common file
structure. If an .mdb file was created using one generation of Access, it is usually
necessary to convert it before it can be used with another version. 

Version 1.5 of the SOIC System uses the Access 2000 file format. Version 1.3 of
the SOIC System used the Access 2.0 file format. These file formats are not
identical. If you have been using SOIC 1.3 and wish to begin using SOIC 1.5 with
your old files, you must convert the Access 2.0 files used by SOIC 1.3 into the
Access 2000 files used by SOIC 1.5. The Convert Access Database Option lets you 



  The SOIC System User’s Manual

Page 98

Figure 51

do this even if you do not own a copy of Access 2000. The Convert Access
Database will convert a database created by previous versions of Access into an
Access 2000 database.

To open the Convert Access Database dialog box, click on Tools and then Convert
Access Database, or press ALT+T, A. The system displays the following box:

In principle, you could type the name of an Access file that you want to convert
directly into the Open File text entry box. In most cases you do not want to do
this, however, because you do not know which folder is considered active by the
dialog box. Instead, click on the Browse button to the right of the Open File text
box. (Alternatively, move to the Browse button with TAB or ALT+TAB and press
ENTER.) The program then displays a file management dialog box, similar to the
following example:
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Figure 52

Figure 53

The folder that opens when you click on Browse can vary. In some cases, the
folder may be the last folder opened. In other cases, it may be a Windows system
default.  

Use the file management dialog box controls to locate the Access 2.0 file you want
to convert. Highlight the name of the .mdb file in the File List to copy the name to
the File Name data entry box. Then press ENTER or click on the Open button. The
name of the .mdb file, complete with the full path of the file, is copied to the Open
File field in the Convert Access dialog box:

If you want to save the new Access 2000 file in the same folder as the old file, just
type the new file name into the Save File data entry box. If you want to save the
new file in a different folder, you can either type the full path and file name into
the Save File data entry box, or use the Browse button to set the folder and file
name for the Save File field.
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You cannot save the new file with the same name in the same folder as the old
file—that is, you cannot over-write the old file with the new one. If you try to do
this, the system displays an error message. If you try to save the new file to a
non-existent folder, the system also displays an error message.

2.8.6  The Trash Can Option

The Trash Can contains records that have been deleted from SOIC System data
tables. You can restore records to an SOIC System data table from the Trash Can.
You can also remove one or more records from the Trash Can, thereby destroying
them forever. The Trash Can is a safety device that allows you to clean up SOIC
System data tables without committing yourself to irretrievable deletions.

You can only place records in the Trash Can when an SOIC System data table is
open. If you delete records from non-SOIC Access tables or from Xbase files, they
are erased immediately and permanently.

You can access the Trash Can by clicking on Tools and then Trash Can with the
mouse, or by clicking on the Trash Can button on the Button Bar located
immediately below the menus. Alternatively, you can press ALT+T, T or ALT+T, UP

ARROW, ENTER. The Trash Can opens:
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Figure 54

If the Trash Can contains more than 15 records, the program displays a scroll bar
on the right-hand side of the window. You can view the additional records by
using the scroll bar, pressing PAGE DOWN, or repeatedly pressing DOWN ARROW.
Likewise, only the first five fields of each record are visible. Additional fields can be
viewed either by using the scroll bar at the bottom of the window or by repeatedly
pressing RIGHT ARROW.

You can highlight a record by clicking on the record line with the mouse, or by
moving to the record with DOWN ARROW or UP ARROW. The highlighted record can be
restored or deleted by clicking on the appropriate button below the table.
Alternatively, you can restore highlighted records with ALT+R and delete them with
ALT+D. Before any record is restored or deleted, the program displays a verification
message box.

You can highlight multiple contiguous records by using most of the standard
Windows techniques for selecting multiple items on a list. You can place the
mouse pointer on the first record to be highlighted, press and hold the mouse
button, move the pointer to the last record, and lift the mouse button. You can
hold down SHIFT while you repeatedly press UP ARROW or DOWN ARROW. You can 
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highlight the first record, move the mouse pointer to the last record, press SHIFT

and then the mouse button.  A group of highlighted records can be deleted or
restored together. 

The purge command, available by clicking the Purge button or pressing ALT+P,
deletes all records in the Trash Can. Before a purge, the program displays a
verification message box.

The Trash Can contains the records deleted from all SOIC data tables. There is no
straightforward way to tell which table a deleted record came from. The Trash Can
therefore can serve as a simple method of transferring small numbers of records
from one table to another. Delete the records in question to the Trash Can, close
the table, open another table, and restore the records. The records are now moved.
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Figure 55

2.9  The Help Menu

You can access the SOIC Help System by selecting the Help item on the menu bar.
The menu bar spans the top of your computer’s screen, and is located above the
Data Entry Form. The menu bar is not available from parts of the program other
than the Data Entry Form. For example, if you have opened a file management
dialog box, the menu bar may be visible, but is not accessible. You cannot access
the menu bar unless you cancel the dialog box and return to the Data Entry
Form. You can, however, access the Help System from anywhere in the program
(except from a message box) by pressing F1.

To access help from the menu bar when the Data Entry Form is active, press
ALT+H or click on the Help item on the menu bar with the mouse. A pull-down
menu appears:

The pull-down menu gives you four options. You can choose any one of them by
clicking on the one you want with your mouse. Alternatively, you can move to the
option you want with the arrow keys and then choose the option with ENTER.

The SOIC Help System is managed by the Windows Help application, a software
program supplied with all copies of Microsoft Windows. The Windows Help
application runs as a separate program from the SOIC System.

Because the Windows Help application runs as a separate program from the SOIC
System, it is possible to switch back and forth between the SOIC System and the
Help System. The Windows keyboard command ALT+TAB switches between running
programs. If you continue to hold down ALT after pressing TAB, Windows displays a
bar containing the icons of all running programs. You can cycle among the icons
by pressing TAB repeatedly. The icon that is highlighted when you finally lift the alt
key represents the program that will become active.

You can close the Help System by clicking on the Cancel button at the bottom of
the window. You can press ESC or ALT+F4. You can also click on the X symbol in
the extreme upper right-hand corner of every Windows window. 
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Figure 56

2.9.1  The Help Contents Option

This option opens the Help system with its initial window displayed. This window
contains the home SOIC Help screen:

Clicking on any of these topics leads you further into the SOIC Help table of
contents, so you can browse for a topic that you want.

You can access the Contents feature from any topic in the Help system by clicking
on the Contents button at the top of the window. You can go to the contents page
from the Data Entry Screen by choosing “Contents...” from the Help menu or by
pressing ALT+H, C.

2.9.2  The Help Index Option

The Help system contains an Index feature that allows you to search the system.
The Index contains an alphabetical list of key phrases that identify help topics:
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Figure 57

You can access the Index feature from any topic in the Help system by clicking on
the Index button at the top of the window. You can go directly to the search
feature from the Data Entry Screen by choosing “Index...” from the Help menu or
by pressing ALT+H, I.

2.9.3  The Help Search Option

The Help system contains a Find feature that allows you to search the system.
Almost every word found anywhere in the SOIC Help system can be located using
the Find feature:
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Figure 58

You can access the Find feature from the Help System by clicking on the Find tab
at the top of the Index window. Find may ask you to generate a database before
you use it. This is not a lengthy process.

2.9.4  The About SOIC Option

The About SOIC option opens a window that contains information similar to what
you would find on the copyright page of a book. The information includes the
exact release number of the version you are running. To choose the About SOIC
option, click on Help and then About SOIC with the mouse, or press ALT+H, A.
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APPENDIX A: Installing the SOIC System on Your Computer

To install the SOIC System, your computer must have Microsoft Windows 95, 98,

2000, Millennium, or NT, and at least 30 megabytes of free disk space. We also 
recommend that your computer have at least a 90MHz Pentium CPU with 32

megabytes of RAM. We have not established any minimum CPU and RAM

requirements over and above the CPU and RAM requirements of Windows itself.

However, the program has not been tested on anything less than a 486 DX2/66

with 32 megabytes of RAM, and we make no guarantees of performance on older,

slower systems. 

The SOIC System requires Microsoft Internet Explorer (IE). The SOIC System is

not Internet-enabled and does not make use of the IE browser. Nevertheless, the

program must have certain supporting files that are used by a variety of Windows

applications, and these files are normally distributed with IE. Note that if you

access the Internet from the same computer that runs the SOIC System, you do

not need to use IE as your browser! You can, for example, use Netscape Navigator

as a browser even if IE is also installed on the system.  

The version of IE that you must have varies with the version of Windows that you

are running. To determine which version of Internet Explorer you have, open

Internet Explorer, then go to Help on the menu bar, then “About Internet

Explorer.”

! Windows 2000: Internet Explorer 5.0 or higher

! Windows ME: Internet Explorer 5.0 or higher

! Windows NT: If you have a version of Internet Explorer that is less than

version 5.5,  you must run the file scr55en.exe, which is located in the

SOIC_Install.zip file.

! Windows 98: You must have Internet Explorer 4.0 or higher. If you have a

version that is less than version 5.5, you must run the file scr55en.exe,

which is located in the SOIC_Install.zip file.
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! Windows 95: You must have Internet Explorer 5.0 or higher. If you have a

version less than version 5.5, you must run the file scr55en.exe, which is

located in the SOIC_Install.zip file.

A.1 Installation

Before installing the SOIC System, close all other active applications.

Once you have saved the file, you may open the file with WinZip or a compatible

decompression utility. If using WinZip, click the Install button in the button bar at

the top of the open window. WinZip will automatically run the appropriate

installation package for you.

If you are using another compatible decompression utility, "unzip" the contents of

the file and run the installation process by double clicking on the SETUP.EXE. 

The installation program begins copying files it needs into your

\WINDOWS\SYSTEM folder and other locations. After a few additional moments,

the Installation program displays a dialog box window:

Figure 59
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Figure 60

Figure 61

If you believe that there is any chance that you have forgotten to close an

application, you can move to the open tasks with ALT+TAB and close them now.

Otherwise, click on the Next button or press ENTER. A second window appears:
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Figure 62

This is the readme file that describes the requirements needed to install the

software, notably the requirement for a version of Microsoft Internet Explorer. If

you believe you have met these requirements, click on Next. The following window

appears:

This window requires you to personalize your copy of the SOIC System. When you

are done, the Next button lights up. Use it or press ENTER to move to the next

window:
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Figure 63

You can use the Browse button in this box to identify the drive and folder in which

you want the SOIC System installed. If you do not specify a drive and folder, the

Installation program will place the program in C:\Program Files\SOIC.  Click on

Next when you are finished. 

The next window prompts you for the program folder name where you would like

the SOIC icon to appear.  You can type in a different name if you prefer:
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Figure 64

Figure 65

Click on Next, and the program now displays a configuration confirmation

window:
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Figure 66

Figure 67

The Installation Program begins copying SOIC files to the appropriate folders.

While the SOIC files are copied, the program displays a screen similar to the

following example: 

After copying the SOIC files, the program may need to install the Microsoft Jet

files. If so, a window similar to the following will appear as the Jet files are copied:
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You may receive a message indicating that you must restart your computer before

running SOIC. If you wish to run SOIC immediately, leave the “Yes, I want to

restart” radio button selected, and click on the Finish button. Otherwise, click on

the radio button labeled “No, I will restart my computer later.”

The SOIC system is now installed.

Every installation dialog box gives you the option of leaving the Installation

program by clicking on the Cancel button or pressing ESC. If an installation is

interrupted, you will need to begin the installation process all over again, from the

beginning. The Installation program, however, is smart enough to detect files it

has already copied, and it will not try to copy these files again. Restarting an

interrupted installation, therefore, does not take as long as performing a new

installation from scratch.

A.2  Copying or Deleting the SOIC System

When the previous SOIC version 1.3 was installed on systems running Windows

3.x, it was possible to move or copy an installed system to a new location, such as

a LAN folder, if you followed certain precautions and took certain steps. Under

Windows 95 and later operating systems, however, the SOIC System should not be

moved manually. Windows 95 logs all applications in the “Registry.” Moving

applications manually can confuse the Registry and various errors can result.

We recommend that you use the installation program to place the system in any

new location. If you want to remove the system from a location, use the Windows

de-installation feature. You can find this feature by opening the Start menu,

choosing the Settings option, then opening the Control Panel window. One of the

items in the Control Panel window is named “Add/Remove Programs.”

Double-click on this icon or name. The Add/Remove Programs Properties dialog

box opens. A list box in the dialog box displays the names of a number of

applications. Find the name “SOIC.” (You may need to scroll down the list to find

SOIC.) Highlight the name and click on the Add/Remove button.
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A.3 Possible Error Conditions

Under certain circumstances, the SOIC System may not run after the installation

process has successfully completed. In almost all cases, the remedy is to de-install

the SOIC System and then reinstall it.

Note that because the Installation Program does not overwrite current versions of

files, the SOIC System can fail to run if a current version of a DLL or other

\WINDOWS\SYSTEM file is corrupted. For example, opening a DLL with a word

processor and saving it can destroy its ability to function—while at the same time

leaving it with a date so recent that the Installation program will not touch it. If

you suspect that one or more system files are corrupt, delete them with Windows

Explorer, de-install SOIC, and reinstall it.
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APPENDIX B: SOIC System Data File Formats

To be successfully imported into the SOIC System, a text file must be in a text

format that the SOIC System can understand. That is, a file must be an “ASCII

text file.” ASCII (the American Standard Code for Information Interchange) is the

standard method of representing alphabetical and numerical characters on

mid-sized and small computers, including PCs, Unix systems, the Apple

Macintosh, and VAX minicomputers using the VMS operating system. ASCII is not

used to represent text on IBM-compatible mainframe computers—these

computers use an alternate system called EBCDIC. Software programs that copy

files from mainframes to smaller systems can almost always translate text files

from EBCDIC to ASCII. These programs, however, typically have the option of not

translating files, and from time to time an EBCDIC text file is copied to a small

system by mistake, and cannot be read. When transferring text files between

different types of systems, therefore, always make sure that the transmitting

software is set to “text” or “ASCII” (depending on the software), not “binary” or

“image.” A binary transfer will not translate your file. 

A second problem is that even systems that use ASCII do not always use the same

set of invisible characters to mark the end of a line of text. MS-DOS and Microsoft

Windows use an invisible carriage return symbol plus an invisible linefeed symbol

to make up a combined “carriage return.” Pressing ENTER in text entry mode in

almost all DOS and Windows programs inserts the combined end-of-line marker,

and ordinarily the way of marking the end of a line is not something you need to

worry about. ASCII-based operating systems other than DOS or Windows,

however, may only use a single invisible carriage return symbol, or a single

linefeed symbol. A binary transfer of such a file preserves the foreign end-of-line

marker. Again, a text or ASCII file transfer solves this problem by converting the

end-of-line marker to the DOS standard.

For an import to succeed, all lines in the imported text file must be the same

length. Some software automatically trims trailing spaces from lines. Each line of

the text file must end with the standard DOS carriage return (carriage return +

linefeed) in the space immediately after the last space used for field information. If

the lines in the text file are 211 spaces long, for example, the DOS carriage return

must be in space 212.
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A text file must also not contain any of the non-ASCII formatting characters often

inserted by word-processing programs. Make sure that the software used to create

the file saves it as a pure text file, without formatting characters.

Finally, the text file must be organized so that the SOIC System can tell where one

field of data ends and another begins, and where one record ends and another

begins. The SOIC System expects a text file in which each record consists of a

single line, ending with a standard DOS carriage return. The individual fields of

each record are in a “columnar” format. That is, each field is identified by its

location on the record line, in spaces. For example, in the SOIC System internal

format, the first field, Local ID, takes up spaces 1 through 4 of the line. The

second field, Temporary ID, takes up spaces 5 through 10. Underlying Cause is in

spaces 207-210, and Autopsy is in space 211. 

It is not necessary that the fields in the imported text file be in the same order as

the fields in an internal SOIC System table. Of course, you may find it convenient

to keep the fields in that order. If that is not convenient, the field mapping

function on import can reorder the fields.

The mapping function can also handle cases where imported fields have different

lengths than the fields in an SOIC System table. If an imported field contains more

characters than the SOIC System allows, the extra characters are trimmed on

import. If you attempt to import a text file with lines more than 211 characters

long, the SOIC System will ignore all data located past space 211. The import will

otherwise succeed.

For general information on how the SOIC System handles files, see Section 2.3,

“How the SOIC System Manages Tables and Files” on page 44. For specific

information on importing text files into the SOIC System, see Section 2.4.7, “The

Import Option” on page 68.

The following table gives the location of the fields in an internal SOIC System data

table. For reference, we also give information on the text file format used by the

National Center for Health Statistics (NCHS). The SOIC System internal format is

based on the NCHS text file format, though the SOIC format has been modified

where necessary. Notably, it contains many additional fields. Non-displayed fields

that the SOIC System uses for internal purposes are not exported. The exceptions

are the fields “ostatus” and “istatus,” which are exported but not displayed.
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Field Name,

SOIC Data Entry

Form

Field Name,

SOIC Internal

Data Format

Field Name,

NCHS Mortality

File Layout

Location

in Spaces

Field

Type

Size

Local ID LocalID Shipment No.

Receipt Month

1-2

3-4

Text 4

Temporary ID TempID <not included> 5-10 Text 6

Certificate ID CertID Certificate No. 11-16 Text 6

Last Name LastName Name of Decedent

Last 17-36 Text 20

First Name FirstName First 37-51 Text 15

Initial Initial Middle Initial 52 Text 1

Alias Alias Alias 53 Text 1

Sex Sex Sex 54 Text 1

Date of Death Dod Date of Death 55-62 Text 8

Social Security SSnum Social Security No. 63-71 Text 9

Age Age Age 72-74 Text 3

Date of Birth DOB Date of Birth 75-82 Text 8

State of Birth POBState State of Birth 83-84 Text 2

Place of Death typePlace Type of Place 85 Text 1

State of Death PODState Place of Death

State 86-87 Text 2

County of Death PODCounty County 88-90 Text 3

Marital Status Marital Marital Status 91 Text 1

Occupation otitle <not included> 92-131 Text 40

Industry ititle <not included> 132-171 Text 40

Code

[Occupation]

Ocode Occupation of

Decedent

172-174 Text 3

Code [Industry] Icode Type of Industry 175-177 Text 3

Residence-State PORState Place of Residence

State 178-179 Text 2

Residence-County PORCounty County/City 180-182 Text 3
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Hispanic Origin Hispanic Hispanic Origin 183 Text 1

Race Race Race 184 Text 1

Education Education Education 185-186 Text 2

Father’s Surname Father Father’s Surname 187-205 Text 19

Work Injury Workinjury Injury at Work 206 Text 1

Underlying Cause cause Underlying Cause 207-210 Text 4

Autopsy autopsy Autopsy 211 Text 1

<internal code,

exported but

not displayed>

ostatus <not included> 212 Text 1

<internal code,

exported but

not displayed>

 istatus <not included> 213 Text 1

<internal code,

not displayed or

exported>

rtind <not included> na Text 3

<internal code,

not displayed or

exported>

icodedby <not included> na Number

(Byte)

1

<internal code> ind1code <not included> na Text 3

<internal code> ind2code <not included> na Text 3

<internal code> ind3code <not included> na Text 3

<internal code> cfind <not included> na Number

(Double)

8

<internal code> indscore <not included> na Number

(Double)

8

<internal code> rtocc <not included> na Text 3

<internal code> ocodedby <not included> na Number 

(Byte)

1
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<internal code> occ1code <not included> na Text 3

<internal code> occ2code <not included> na Text 3

<internal code> occ3code <not included> na Text 3

<internal code> cfocc <not included> na Number

(Double)

8

<internal code> occscore <not included> na Number

(Double)

8

<internal code> disagree <not included> na Text 3

<internal code> stime <not included> na Text 8

<internal code> ftime <not included> na Text 8

The following table gives the code structure for the fields of the NCHS Mortality

File. The code structure indicates the possible valid responses and, where the

fields are coded, what the codes mean.

Field Name Code Structure

Shipment Number 01-19

Receipt Month 01-12 (Jan.=01; Dec.=12)

Certificate Number Numeric, left zero fill

Last Name Alpha, left-justify (20 char.)

First Name Alpha, left-justify (15 char.)

Middle Initial Alpha or blank (1 char.)

Alias 1 or blank

Sex Male=1, female=2, not classifiable=9

Date of Death Month (first two spaces): 01-12, not classifiable=99

Day (next two spaces): 01-31, not classifiable=99

Year (last two spaces): last two digits of year 

[NOTE: The SOIC System calls for all four digits of the year.]

Social Security Number Numeric or blank
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Age Units (first space): years less than 100=0, years 100 or more=1,

months=2, weeks=3, days=4, hours=5, minutes=6, not

classifiable=9

Number of units (second and third spaces): enter as stated. 

Not classifiable=99

Date of Birth Month (first two spaces): 01-12, not classifiable=99

Day (next two spaces): 01-31, not classifiable=99

Year (last three spaces): last three digits, not classifiable=099

 [NOTE: The SOIC System calls for all four digits of the year.]

Decedent’s Birthplace If state, 01-51; Puerto Rico=52, Virgin Islands=53, Guam=54,

Canada=55, Cuba=56, Mexico=57, remainder of world=59,

not classifiable=99 [FIPS codes]

Type of Place of Death Hospital: inpatient=1, outpatient/ER=2, DOA=3, status

unknown=4

Other: nursing home=5, residence=6, other=7

Not classifiable=9

Geographic Place of

Death, State

01-54 [FIPS codes]

Geographic Place of

Death, County

Refer to Part 8, Geographic Classification, 1982. [FIPS codes]

(There is no valid unknown code for county. If information

is unknown, assign the same code as the previous record.)

Marital Status Married=1, never married=2, widowed=3, divorced=4, not

classifiable=9

Occupation Instruction Manual, Part 19 (This is the code, not the literal.)

Industry Instruction Manual, Part 19 (This is the code, not the literal.)

Residence of Decedent,

State

If state, 01-51; Puerto Rico=52, Virgin Islands=53, Guam=54,

Canada=55, Cuba=56, Mexico=57, remainder of world=59,

not classifiable=99. Also see 1991 NCHS Instruction

Manual, Part 4. [FIPS codes] 

Residence of Decedent,

County/City

Refer to Part 8, Geographic Classification, 1982. Also see 1991

NCHS Instruction Manual, Part 4. [FIPS codes] 

Hispanic Origin Non-Hispanic=0, Mexican=1, Puerto Rican=2, Cuban=3,

Central or South American=4, other and unknown

Hispanic=5, not classifiable=9
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Race White=1, Black=2, Indian=3, Chinese=4, Japanese=5,

Hawaiian=6, Filipino=7, other Asian/Pacific Islander=8,

other=0, not classifiable=9

Education 00-17, not classifiable=99

Father’s Surname Alpha, left-justify or blank

Injury at Work Yes=1, no=2, not classifiable=9

Underlying Cause of Death ICD-9

Autopsy Yes=1, no=2, not classifiable=9
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APPENDIX C: The 998 Insufficient Information Code

Based on recommendations from the SOIC Policy Committee, the SOIC Software

was designed to assign a code of 998 when there is insufficient information

present to reliably assign an informational code. 998 can be assigned to either

industry or occupation. The meaning of a 998 assignment is different from that of

a 990/999 assignment. 990/999 will continue to be used for blanks, unknown,

refused, etc. 998 is not technically a code assignment, but rather an indicator that

although there was some information present in the industry or occupation

descriptions, that information was insufficient for ascertaining a code.

All decisions regarding the criteria by which a case is to be assigned 998 were made

by the SOIC Technical Committee. The committee was formed in 1997 and was
comprised of a panel of coding experts from the Bureau of the Census (BOC), the

National Institute for Occupational Safety and Health (NIOSH), and the National

Center for Health Statistics (NCHS). The committee was responsible for reviewing

coding conflicts and hard-to-code cases, and was instrumental in improving

the quality of the SOIC software.

The use of 998 provides two key benefits: the ability to measure the overall quality

of information in a data set, and the ability to identify cases with insufficient

information so that they can be returned to their source for clarification whenever

possible.

The SOIC software offers several features to assist in working with 998 cases. The

Find Record option (Section 2.6.6 on page 83) allows you to search for individual

records assigned 998 in either industry or occupation. The Print option (Section

2.4.9 on page 76) allows you to print only 998 cases. For data stored as internal

SOIC tables, the Save 998 Codes option (Section 2.4.4.3 on page 64) allows you to

save 998 cases as a separate SOIC or Access table.
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